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Disclaimer
This manual and the information contained herein are the sole property of EVS Broadcast
Equipment SA and/or its affiliates (EVS) and are provided “as is” without any expressed or
implied warranties, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose. In particular, EVS makes no warranty regarding the
use or the consequences of use of this manual and the information contained herein.
Furthermore, EVS may not be held liable for any direct or indirect, incidental, punitive or
consequential loss, damage, cost or expense of any kind whatsoever and howsoever
resulting from the normal or abnormal use of this manual and the information contained
herein, even if advised of the possibility of such loss, damage, cost or expense.

While every effort has beenmade to ensure that the information contained in this manual
is accurate, up-to-date and reliable, EVS cannot be held liable for inaccuracies or errors
that may appear in this publication. The information in this manual is furnished for
informational purpose and use only and subject to change without notice.

This manual cancels and replaces any previous versions thereof.

Copyright
Copyright © 2003-2020 EVS Broadcast Equipment SA. All rights reserved.

This manual may not be reproduced, transcribed, stored (in a database or a retrieval
system), translated into any language, computer language, transmitted in any form or by
any means – electronically, mechanically, printed, photocopied, optically, manually or
otherwise – in whole or in part without the prior written consent of EVS.

Trademarks
All product and brand names are registered trademarks and trademarks of EVS or of their
respective owners.

Improvement Requests
Your comments will help us improve the quality of the user documentation. Please send
improvement requests, or report any error or inaccuracy on this user manual by e-mail to
doc@evs.com.

Regional Contacts
Youwill find the full list of addresses and phone numbers on the following webpage:
http://www.evs.com/contact.

USER MANUAL IPDirector 7.90 Database Explorer

I

mailto:doc@evs.com
https://www.evs.com/contact


User Manuals on EVS Website
The latest version of the user manual, if any, and other user manuals on EVS products can
be found at the EVS download center, on the following webpage:
https://www.evs.com/en/download-area.
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What's New?

In the User Manual, the icon has been added on the left margin to highlight
information on new and updated features.

The sections updated to reflect the new andmodified features in Database Explorer
version 7.90 are listed below.

Automatic creation of clips based on logs

If a specific bin has been selected in the logsheet, clips will be automatically created when
a log is being created.

• See section "Creating Clips Automatically from a Log Entry" on page 76.

Publishing media to social media

A workflow target is available to sendmedia to several social media at once.

• See section "Possible Transfer Destinations" on page 111.

• See section "Clip Contextual Menu" on page 30.

• See section "Playlist Contextual Menu" on page 47.

The Transfer Monitoring window shows subtasks corresponding to the publication to
multiple social media with a single workflow target.

• See section "Overview of the Transfer Monitoring Area" on page 123.

A specific icon is displayed in the Status columnwhen amedia is sent to a workflow
target involvingmultiple social media.

• See section "Transfer Status Icons" on page 124.
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1. Introduction

1.1. Product Overview
The Database Explorer is a central point in the IPDirector application to perform search on
all themedia available on the network and to loadmedia by a simple operation such as
drag-and-drop or double-click.

The Database Explorer gives a view on themedia in terms of clips, clip elements,
playlists, edits, timelines, logs or media files. Even the files backed up on removable
drives which have been removed (off-line nearline files) are still listed in the Database
Explorer to allows easily retrieving the drive.

In the Database Explorer, you can access themedia and data, either by using your
knowledge of the "clip hierarchy" methods used in EVS video servers or by using quick or
advanced search techniques.

Bins can be created to organize clips, playlists, edits and timelines and bin rules can be
defined to automatically copy these items within a bin corresponding to a specific applied
filter.

Many operations are possible from the Database Explorer. It must be noted that some of
the operations are directly described in the chapters dedicated to the other modules of
IPDirector.

1.2. Opening Database Explorer

To open the Database Explorer, select the corresponding icon on
the IPDirector Application bar. An instance of a Database Explorer window will open.  It is
possible to openmultiple DB Explorer windows at one time.
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2. User Interface

2.1. Overview of the Database Explorer

Illustration
The Database Explorer window contains the areas highlighted on the screenshot below:

NOTE

From version 6.55, the interface skin has slightly changed, so the color shade
of some user interface elements (such as title bar, buttons) may differ from the
screenshots included in the current manual.

2 2. User Interface
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Area Description
The table below describes the various parts of the Database Explorer window:

Area Description

1. Toolbar The toolbar on the top of the Elements grid provides a series of buttons
mainly for viewing, browsing and playing options, as well as a Tools
menu to define options for the Elements grid display.
See section "Toolbar" on page 4.

2. Tree
View

The Tree view shows the different branches of all the items from the
database content. It can be used to filter items in the Elements grid:
clips, clip elements, playlists, timelines, edits, bins, logs, media files.
Depending on the user rights, the user may see different parts of the
tree.

NOTE

Formost of the users, the Clips, Playlists, Timelines, Edits,
Bins and Logs branches in the Database Explorer tree are the
only ones they may access.
Administrators and users with the necessary permissions
canmanipulate clip elements or media files.

See section "Tree View" on page 9 for details on the interface.

3. Elements
Grid

The Elements grid displays all the items included in the selected tree
branch or resulting from a search.
See section "Elements Grid and Search Options" on page 12.
Above the grid, functions to perform quick text or timecode searches, or
advanced searches onmetadata are available.

4. Status
Bar

This area provides information regarding the Database Explorer. These
include: the number of elements (in the currently displayed grid, based
on filters and searches applied), the next clip to be played out (applicable
for playout modes), the Auto-Refreshmode, the association status with
a BEPlay Remote and the DB explorer's associated player channel.
See section "Status Bar" on page 17.

5. Saved
Filters
Pane

This area provides functions to save applied filters or recall and apply
saved filters to the current search.
See section "Saved Filters Pane" on page 18.
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Adaptable Display
The layout of the Database Explorer can be adapted to users' needs:

• the Saved Filters Pane can be shown by clicking the button

or hidden by clicking the button.

• most of the panes can be enlarged or reduced by moving the intersection line between
them.

2.2. Toolbar

2.2.1. Toolbar Options
The toolbar is located on the top of the Elements grid.

The following table gives a description of the options and buttons located on the toolbar.

Interface Element Description

Tree button: Shows or hides the tree structure
area.

View option: displays amenu listing
• additional media types which can bemade

visible in the tree view. See section "View
Menu" on page 6.

• the display options for the elements within
the grid.

Print button: used to print the Elements grid
currently displayed.

4 2. User Interface
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Interface Element Description

Browse button. When the Browsemode is
enabled, selecting an element will
automatically load it on the associated player
channel, ready to play.
The button can only be used when a channel
is assigned to the Database Explorer. It
becomes colored when selected.
See section "Loading and PlayingMedia" on
page 127.

Play button. When the Play mode is enabled,
selecting an element will automatically play it
on the associated player channel.
The button can only be used when a channel
is assigned to the Database Explorer. It
becomes colored when selected.
See section "Loading and PlayingMedia" on
page 127.

Auto-Play button. The Auto-Play mode
makes it possible to play a list of elements
one after the other on the associated player
channel, as they are displayed in the
Database Explorer window. The elements are
played without transition effects.
The button can only be used when a channel
is assigned to the Database Explorer. It
becomes colored when selected.
See section "Loading and PlayingMedia" on
page 127.

Photo button: used to grab a thumbnail of the
clip or playlist loaded on the player channel
which is associated to the Database Explorer.
See section "Photo Button" on page 8.

Refresh button: performs amanual refresh of
the Elements grid.

Tools option: displays a contextual menu with
various options for themanagement of the
Database Explorer operations.
These options are described in "Tools Menu"
on page 8.

Assign button: used to assign keywords to
one or several clips.
See section "Assigning a Keyword from a
Keyword Tool" on page 135.
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2.2.2. View Menu
Depending on your user rights, you will be allowed to view different parts of the tree and
somemenu items could be unavailable.

Clicking theView button displays amenu with different options:

• options tomake some additional media types visible in the tree view.

• options to select the type of view in the Elements grid.

Show off-line IP Drive storages
Shows all the off-line files in the interface.
Shows the IP drives storage units wheremedia have been backed up, even if the drives
have been removed. This allows the user to easily search for archivedmedia information.
All off-line files are displayed in italic gray text in the grid, and will have amodified File
icon with a red border. See section "Clip Element Types" on page 19 for the list of icons.

Show Clip Elements plug-in
Available for Administrators/Media Managers or high resolution/low resolution browsers
according to assigned user rights.
Shows the Clip Elements branch in the tree with sub-branches for XT clips, on-line and
off-line nearline files.
The Elements grid corresponding to the Clip Elements tree branch is intended to show the
clip elements individually.

Show Media Files plug-in
Available for Administrators/Media Managers or high resolution/low resolution browsers
according to assigned user rights.
Shows theMedia Files branch of the tree with sub-branches for on-line and off-line
nearline files.
Enables theMediaManager to perform actions on files, such as delete, move, and
analysis of the file discovery status and errors.

Show ArchiDel Elements
Shows the files which have been archived to a HSM and deleted from the nearline (=
ArchiDel status).
As these files are off line, they are displayed in italics in the Elements grid for the Clips
view.
This option is available provided that the user has theUser can see archidel media right.

Simple List
In the Elements grid, items are displayed in a list without thumbnails. Their metadata
appear in columns.

Simple List with Thumbnails
This option is only displayed when the Clips or Clips Elements branches are selected in
the Tree View.
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In the Elements grid, items are displayed in a list with a thumbnail. Their metadata appear
in columns.

Fill Key
This option is only displayed when the Clips or Clips Elements branches are selected in
the Tree View.
In the Elements grid, items are displayed in a list with a thumbnail. Their metadata appear
in columns.
A Key Thumbnail column shows the thumbnail of the Key clip associated with the Fill clip.

Thumbnails View
This option is only displayed when the Clips, Clips Elements or Logs branches are
selected in the Tree View.
In the Elements grid, a thumbnail with a few metadata is displayed for each item.
Trains are highlighted in orange.
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2.2.3. Photo Button
A thumbnail is created automatically by Xsquare in the folder defined for the Thumbnails
for Clips option in the Remote Installer. Please see the Technical Referencemanual for
further details.

ThePhoto button, or the + keyboard shortcut, is used tomanually create
a thumbnail which will replace the previous one.

Then, the thumbnail will correspond to the current timecode position of the clip or the
playlist loaded on the player channel which is associated with the Database Explorer
when you click thePhoto button.

ThePhoto button is only available when an A/V board has been activated and linked to
the player channel in the Remote Installer. Refer to the General Functions user manual.

2.2.4. Tools Menu
Menu Item Description

Auto-Refresh
Mode of
Database
Explorer

Selects/de-selects Auto refreshmode for the grid.
When large amounts of data are present, the automatic refresh can
slow down the system. To only refresh the system on demand,
disable this option.

You can do amanual refresh by clicking theRefresh button

Auto-Refresh
in filter mode Selects/de-selects Auto refreshmode for the grid in Filter mode.

Limit Result
count

When enabled, the Limit Result Count option will limit the results of
any search to the number of elements defined in the IPDirector
Remote Installer (1000 elements by default).
Refer to the Technical ReferenceManual for more information.

Insert mode A submenu proposes the following options:
• First: new items will be inserted at the top of a list
• Last: new items will be inserted at the bottom of a list
• First Display: new items will be inserted at the top of the visible

part of a list
• Sorted: new items will be inserted at their sorted position in a list

Transfer
Monitoring

Transfer monitoring is explained in section "Monitoring the Transfer
Status" on page 123.
Available for administrators and users with appropriate user rights.

My transfer
only

When enabled, this option only shows you the transfers that you
initiated.

Clip Element
Association

Enables tomanually associate a clip element to an existing clip with
matching TC. See section "How toManually Associate a Clip
Element to an Existing Clip" on page 45.
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2.3. Tree View

2.3.1. Introduction
The Database Explorer is presented in a tree structure, much likeWindows Explorer.

 OR 

The tree view allows browsing and performing search in the database and nearline
storage. Clicking the arrow next to a tree branch expands it. The selected branch content
is displayed in the Elements grid. See section "Selecting the Type of Media Items in the
Tree" on page 80.

Depending on the user rights, the user can see different parts of the tree.

Administrator or MediaManager will have full rights and therefore could be able to see all
the tree branches available.

2.3.2. Tree View Elements
The table below mentions which items are displayed in the Elements grid based on the
tree branch selected.

Tree Branch Description

Clips The Clips branch is visible by all the users.
It displays the list of clips present in the database and on the
nearline storages in the Elements grid. Each clip is displayed on a
separate line within the Elements grid and the view can be
expanded to display the different clip elements making up the clip.
It also lists the record trains from the servers present on the XNet.
Clips can be A/V files, audio files, stills, logos and CG templates
for use with the Xedio Character Generator tool.
See section "Clips View" on page 27 for more information on the
Clips branch of the tree.

Clip Elements
(not visible for
most users)

It displays the list of clip elements present in the database and on
the nearline storages in the Elements grid. Each clip element is
displayed on a separate line within the Elements grid.
See section "Clip Elements View" on page 41 for more information
on theClip Elements branch of the tree.
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Tree Branch Description

Playlists It displays all the playlists present in the database and on the
nearline storages in the Elements grid. Sub-branches list the on-line
and off-line playlists separately.
See section "Playlists View" on page 46 for more information on the
Playlists branch of the tree.

Timelines It displays timelines present in the database in the Elements grid.
See section "Timelines View" on page 53 for more information on
the Timelines branch of the tree.

Edits It displays all the edits present in the IPDirector database in the
Elements grid. Edits may have been created from the Xedio IPD
Plugin, the Director's Cut module of IPDirector or the IPBrowse
application. They can also be created by the IPMosGateway
NRCS systems as Autocreate placeholders. Edits can only be
modified from the CleanEdit interface.

Bins Sub-branches shows the bins and bin directories.
The Elements grid contains four tabs, Clips, Playlists, Timelines
andEdits, to display respectively the clips, playlists, timelines and
edits which have been sent to the selected bin or bin directory.
See section "Bins View" on page 61 for more information on the
Bins branch of the tree.

Logs It displays all the logs in the Elements grid. Sub-branches are
displayed for each logsheet and for any log directory which have
been created.
See section "Logs View" on page 73 for more information on the
Logs branch of the tree.

Media Files
(not visible for
most users)

It displays all the files which have been saved on a nearline storage
in the Elements grid. Sub-branches may be available for on-line
high resolutionmedia files, on-line low resolutionmedia files, off-
line high resolutionmedia files, off-line low resolutionmedia files.
They are listed with full file name, file extension and full path of their
physical storage location.
See section "Media Files View" on page 78 for more information on
theMedia Files branch of the tree.
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2.3.3. Clip Tree Structure

The Clips branch is visible by all the users. Themain branch displays all the clips from the
sub-branches.

Within the Clips tree structure, the following sub-branches are available:

• Physical hardware present on the XNet, such as:

◦ high resolution EVS video servers: displays clips containing a high resolution clip
saved on the high resolution EVS video servers.

Light clips are listed here as well even if they are not saved on a server but only
refer to a normal clip itself saved on a server.

◦ low resolution EVS video servers: displays clips containing a low resolution-clip
saved on the low resolution EVS video servers.

TheShow Lores tree optionmust have been selected from the View contextual
menu.

◦ Hardware hosting XFile software: displays clips which have been backed up to
XFile and then published from XFile to the XNet.

Even if an XT clip is backed up to XFile in a file format, when the file is published
from XFile, it appears with aClip icon in the Elements grid.

Eachmachine can be searched by browsing the tree from network number > page >
bank.

• On-line nearline: displays clips which have been backed up to nearline/IP drive and for
which the nearline/IP drive is still accessible, so clips can still be immediately
retrievable.
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• Off-line nearline: displays clips which have been backed up to nearline/IP drive and for
which the nearline/IP drive cannot be accessed anymore. So, IP drive identification
allows clips to be retrieved after re-inserting the drive, for example.

TheShow offline IP Drive storages optionmust have been selected from the View
contextual menu.

2.4. Elements Grid and Search Options

2.4.1. Quick Text Search Area

Introduction
TheQuick Text Search is used to perform a search based on free text entered in the
Quick Text Search field. This field is available on the top of the Elements grid. You can
perform a search on displayed columns or a search on all columns (displayed and hidden
columns).

The search is performed on the selected tree branch.

See section "Quick Text Search" on page 82.

Search and Filter Associated Buttons
The following table gives a description of the buttons located next to theQuick Text
Search field. These buttons may be used not only for the Quick Text Search function but
also for the other search functions in the grid.

Interface
Element Description

To perform a search on all columns of the Elements grid (even the
hidden ones), you first need to activate theSearch on All Columns
option. This option is accessible from the down arrow next to the
Search button:

See section "Quick Text Search" on page 82 for more information on
quick text searches on displayed or all columns.

Applies the search again and refreshes the Elements grid.

Displays the Syntax Rules list. See section "Quick Text Search
Syntax Rules" on page 84.
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Interface
Element Description

Clears the applied Quick Text search.

Saves the filter applied in theQuick Text Search field and/or in the
Advanced Search fields. See section "Using Saved Filters" on page
106.

Clear All button: clears all the applied searches.

2.4.2. Quick Timecode Search Area
To display theQuick Timecode Search field, you need to click the down arrow next to
theSearch button and select Display Timecode Search from themenu:

By entering a timecode value in theQuick TC Search field, you can perform a quick
search on a timecode value within the elements displayed in the grid.

See section "Quick Timecode Search" on page 81 for more information on timecode
searches.

2.4.3. Advanced Search
Advanced Search functions are available for detailed search operations. They allow
searches onmetadata displayed in the grid columns.

TheGrid Filter bar can be displayed just over the Elements grid by clicking theSearch

button above the grid:

To hide the Grid Filter bar, click theSearch button once again.

See section "Advanced Search" on page 88 for more information on grid filters.

USER MANUAL IPDirector 7.90 Database Explorer

2. User Interface 13



2.4.4. Elements Grid

Elements Grid Display
The Elements grid represents the content of the tree branch selected in the Tree view. The
list of elements can be refined by applying one or several search criteria.

In the grid, elements are presented in rows and all their associated parameters and
metadata are in columns.

Grid Header Contextual Menu
Right-clicking the grid header displays the grid contextual menu.

The options are described in the following table:

Option Description

Hide Hides the selected column.

Organize The Select Columns window opens and allows the users to select the
columns to display and their order.

Save grid
organization

Saves the organization of the grid as it is displayed (columns selection,
order and size). It is saved by each user. Therefore, this organization
will be retained the next time the user logs in and opens the application.

Reset grid
organization

Sets back the grid to the default grid organization for each type of items
which can be selected from the Tree view.

Sorting the Elements in the Grid
At start of the application, items are sorted with most recent on top.

You can change the sort order of elements in the grid by clicking the column header for the
parameter according to which you want to sort the elements.

The column header which is used for sorting is highlighted in blue. The little triangle
indicates the sorting order. Clicking the column header again changes the sorting order
from ascending to descending or vice versa.

Organizing Columns
Columns can be resized and/or re-ordered. This new organization is automatically saved
and remembered. However, it is also possible to reset the column organization to the
default organization.
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Resizing Columns
A column can be resized by placing themouse pointer over columns intersection and
dragging it to the right or to the left.

Selecting Columns to Display
To select the columns to display in the grid,

1. Right-click the column header area.

2. Select Organize.

The Select Columns window opens and the right pane shows the list of columns
currently displayed in the current order.

3. To select the column(s) you wish to add to the view, do one of the following actions:

◦ in the left pane, double-click the column(s) you wish to add to the view

◦ select them in the left pane and click the right arrow

◦ drag them onto the Visible Columns area.

UseCTRL + click to select a list of non-contiguous columns.

UseSHIFT + click to select a list of contiguous columns.

4. To select the column(s) you wish to remove from the view, do one of the following
actions:

◦ on the right pane, double-click the column(s) you wish to remove from the view

◦ select them on the right pane and click the left arrow

◦ drag them onto the left pane.

UseCTRL + click to select a list of non-contiguous columns.

UseSHIFT + click to select a list of contiguous columns.

5. Click OK.
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Ordering Columns
To change the columns order, proceed in one of the following ways

• Select a column header and drag it to the left or right to the required place:

OR

1. Right-click the column header area.

2. Select Organize.

The Select Columns window opens and the right pane shows the list of columns
currently displayed in the current order.

3. Drag the selected column to the required position in the Visible Columns pane.

4. Click OK.

Resetting the Column Organization to the Default One
Users can reset the column organization to the default one (columns selection, order,
size,...). This will be done for all types of items at once.

1. Right-click the column headers area.

2. Select Reset Grid Organization.

Resetting the List of Columns back to the Default One
Users can reset the list of columns displayed in the grid to the default one. This will be
done only for the type of items currently selected from the Tree view.

1. Right-click the column header area.

2. Select Organize.

The Select Columns window opens.

3. Click Back to Default.
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2.5. Status Bar
The Status bar contains five areas, from left to right, shortly described in the table below.

Element Number
The first zone of the Status bar shows how many elements are included in the Elements
grid of the Database Explorer:

As soon as one or several elements have been selected in the grid, the number of selected
elements is displayed between brackets:

Next Clip zone
• The second zone shows the next clip (in green) to be played if the Auto-Play mode is

active.

• The text is orange if the Auto-Play mode is not active:

Auto-Refresh zone

The third zone displays the Auto-Refresh status. Its background is green when it is ON, or
red when it is OFF. See section "Tools Menu" on page 8.

Associated BEPlay Remote zone
The fourth zone gives indication on the association status to a BEPlay Remote.

• is shownwhen no BEPlay Remote is
connected to the IPDirector.

• is shownwhen a BEPlay Remote is connected to the
IPDirector but it is not associated to the Database Explorer.

• is shownwhen a BEPlay Remote is associated to the
Database Explorer.

To link or unlink a BEPlay remote to a Database Explorer, double-click the BEPlay
Remote zone.
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See theGeneral Functions user manual for details on the configuration and use of the
BEPlay remote.

Associated Channel zone
• The fifth zone shows the associated player channel, if any:

See section "Assigning a Player" on page 127 for more information on how to assign a
player channel.

• When no channel is associated to the Database Explorer,

is shown.

• If the selected player channel is connected to an IN port of a video router, itself
associated to OUT ports, the name of the router OUT port(s) is displayed after the
player channel name:

2.6. Saved Filters Pane
The Saved Filters pane can be displayed by clicking theSaved Filters button.

With this mode, you can save filters defined in the grid thanks to the quick search fields
and/or the grid filter bar. You can also apply filters previously saved.

See section "Using Saved Filters" on page 106 for more information on the search saving
functions.
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3. Clips, Clip Elements and
Nearline Files

3.1. Terminology
Term Definition

Nearline Any IT storage, other than the EVS video servers, present on the network and
where A/V material can be backed up or from which A/V material can be
retrieved. These IT Storage devices are inventoried into the IPDirector
database.
Examples of nearline storage: IP drive, XFile drive, SAN, NAS…

On-line
nearline

A nearline is displayed as on-line in the database tree when the next two
conditions aremet:
• It is accessible (IP address can be "pinged")
• It is managed by a SynchroDB

On-line
nearline
file

A file stored on an on-line nearline storage and which has been treated by the
SynchroDB.
It can be a high resolution file or a low resolution file.

Off-line
nearline
file

A file stored on an nearline storage which is nomore on-line, either because it
is no longer accessible or because it is nomoremanaged by a SynchroDB.
It can be a high resolution file or a low resolution file.

3.2. Notions About Clips

3.2.1. Clip Element Types
A clip is a logical entity that contains A/V media and can include several physical
resources (XT clips and/or files).

A clip element is the physical resource inside the clip: XT clip or nearline file.

A clip and its clip elements share the same TC IN, TC OUT andmetadata set.

A clip can contain several types of clip elements and each of them is identified in the Clip
Elements column of the Elements grid by a distinct icon, as detailed in the table below.

Icon Clip Element Description

high resolution XT
clip

high resolution clip or growing clip stored on an EVS
video server.

low resolution XT
clip

low resolution clip or growing clip stored on an EVS
video server.
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Icon Clip Element Description

on-line high
resolution nearline
file

high resolution file stored in nearline folders, IP drive is
on-line (accessible andmanaged).

on-line low resolution
nearline file

low resolution files stored in nearline folders, IP drive is
on-line (accessible andmanaged).

off-line high
resolution nearline
file

high resolution files stored in nearline folders, IP drive is
nomore on-line.

off-line low
resolution nearline
file

low resolution files stored in nearline folders, IP drive is
nomore on-line.

high resolution
archived file

high resolution file archived in HSM.

low resolution
archived file

low resolution file archived in HSM.

Depending on the user rights, the user can see different element types. The tables in
section "View Menu" on page 6 givemore details on the user rights.

NOTE

There can be several copies of the same element within a clip.

3.2.2. Clip Content Types
Various types of media are considered as clips. Thosemedia types are A/V files, audio
files, stills and logos. All are displayed in the Clips view of the Elements grid.

TheContent Type column provides the indication on themedia type. Those are
Audio/Video (for A/V files and logos), Audio only (for audio files), Still (for still files).

3.2.3. Clip LSM ID

Understanding Clip Numbering Hierarchy on an
EVS Video Server

Introduction
One library method used by IPDirector is to mimic the hierarchical structure adopted by
the EVS range of servers to storemedia, which is based on the remote panel design with a
limited amount of buttons and desk space.

Multicam can store up to 900 clip numbers (multiplied by the number of camera angles)
and 100 playlists on an EVS video server.
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When the EVS server operates in 6-channel mode, this makes it possible to store 900
clips with up to 6 camera angles per clip, which results in 5,400 clips on an EVS video
server.

When the EVS server operates in 12-channel mode, this makes it possible to store 900
clips with up to 12 camera angles per clip, which results in 10,800 clips on an EVS video
server.

Clip Hierarchy Diagram
The following diagram represents the hierarchy of theMulticam clip numbering system. As
an example, clip number "129C" is used:

The number of the EVS video server within the network structure is also added to define
the precise location of the clip. For example if clip 129C is stored on themachine allocated
with the network number 2, the clip would be identified as 129C/02.

The LSM ID is this identificationmade up of page nr + bank nr + position in the bank +
server nr.
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Virtual LSM ID / Real LSM ID

Real LSM ID
The real LSM ID reflects the location where a high resolution XT clip or a low resolution XT
clip will be saved, as described in section "Understanding Clip Numbering Hierarchy on an
EVS Video Server" on page 20.

In the Elements grid displayed from the Clip Elements view, the real LSM ID is always
mentioned.

Virtual LSM ID
From the Clips view, a single LSM ID is displayed for a clip. It is called the virtual LSM ID.

• If a high resolution XT clip is present in the clip, it will be the LSM ID of the high
resolution XT clip,

• If there is no high resolution XT clip in the clip, this field will be left empty.

When the LSM ID of the high resolution XT clip is changed, the virtual LSM ID is changed
as well.

When the LSM ID of the high resolution XT clip is deleted, the virtual LSM ID is removed
and the LSM ID field is left empty.

When the LSM ID of the high resolution XT clip appears in a clip, the virtual LSM ID is
updated tomatch.

So, if a low resolution XT clip is present in the clip, the only way its real LSM ID can be
retrieved is from the Clip Elements branch of the tree. This view and function should only
be used by system administrators andmediamanagers.
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3.2.4. Normal Clip Versus Light Clip

Purpose
When a lot of users work on IPDirector, they can create a large amount of clips. This can
potentially lead to a situation where toomany XT clips are created on the EVS video
server and where the database is overloaded by resource-consuming processes.

The concept of light clip has been introduced to avoid the creation of a large amount of
clips on an EVS video server. A specific user right is required to be able to create light
clips.

Normal Clip
When a clip is created from a live train, it will be a normal clip, stored on an EVS video
server with a LSM ID.

Light Clip
When a sub-clip is created from a normal clip, a light clip will be created which contains an
XT clip element. This XT clip element will be stored in the IPDirector database but not on
the EVS video server because it is actually a reference to the original XT clip present on
the server. So, no LSM ID will be associated with the XT clip element from the light clip.

In the example below, the first clip is the normal clip created from the train and the second
clip is the light clip created by sub-clipping the normal clip:

A light clip will not be taken into account in heavy processes such as clip-log auto-
associations, bin filters,…
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3.3. Nearline Management

3.3.1. Purpose
XT clips can be sent to a nearline for backup purpose. They are saved on the nearline as
files. Physical storage such as IP drive (or XF drive) can be used as nearline. A clip which
only contains a nearline file can be restored to an EVS video server, for example for
playout purpose.

Once a nearline directory has been configured in the Remote Installer, IPDirector will
continuously scan the directory path looking for new files or files being deleted. The IP
drive service will also automatically detect the appearance of a new IP drive, or XFile disk,
or the ejection of a drive.

3.3.2. Files Types
All the files appearing on the nearline storage are filtered according to a list of supported
extensions. Depending on the extension, they will or will not be visible in IPDirector.

Files can be classified among three types.

Files with a non-supported extension and which are not video files
They will be ignored and will not be visible in IPDirector.

This could be an EVS XML file without an associated A/V file or this could be a file with a
non-supported extension like a dll, or a text file.

Files with an extension not supported on the nearline
They will be visible in theMedia Files branch of the tree, but no clip will be created, so they
will not be visible in the Clips branch of the tree for most users.

The import status of this kind of files will be "unsuccessful" in the Import Status column of
theMedia Files node with the error message stating "unsupported format".

In a future version of IPDirector, it will be possible to import these files by initiating a
transcoding process.

Files with an extension supported on the nearline
They will be visible in theMedia Files and in the Clips branches of the tree.

This is the case for EVS MXF, QT, OP1A, Proxy (lo-res) and DV DIFF files.

In addition, somemulti-files formats, having separate files for audio, video, and
sometimes a reference file, are now supported by IPDirector. With such files, IPDirector
links the different components and only one file appears in theMedia Files grid.

This is the case for QT Ref, OPAtom andMPEG 1Elementary System.
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Metadata of this third kind of files can be obtained from three different sources which will
be reflected in themetadata source column of theMedia Files node:

Metadata Source Metadata Source Column

XML metadata file XML

Header of an EVS MXF file EVS MXF

nometadata None

TheMetadata files are automatically updated when clip metadata are changed.

3.3.3. Error Messages
The following error messages could appear in theError Message column of the Database
Explorer grid:

Error Message Source of the Error

Could not read metadata file Badmetadata file: corrupted file or bad
syntax.

Some compulsory tags are missing from
the XML metadata file

Badmetadata file: missing tag or
incoherent data (e.g. IN < OUT).

Bad data in one or more metadata tag Badmetadata file: bad/incoherent data
(e.g. IN < OUT, bad value).

Unsupported A/V format. You need to
transcode your file before importing it to
IPDirector nearline.

Unsupported A/V format (recognized
by Timecode Extractor but not
supported natively).

Could not read A/V file. This file might be
corrupted or in the wrong format.

Corrupted A/V file. Timecode
Extractor or EVS MXF.dll cannot read
the file.

3.3.4. Supported Codecs
The following codecs can bemanaged by the nearline:

• SD: MJPEGSD, MJPEGProxy, IMX 30, IMX 40, IMX 50, DVCPRO 25, DVCPRO
50, MPEG-1, MPEG-2, MPEG-2 (I-Field), DV25, H-264.

• HD: MJPEGEVS HD, MJPEGStandard HD, MPEG-2, MPEG-2 (I-Field), MPEG-2
HD (I-frame), Avid DNxHD® Lo, DNxHD® Hi 8 bits, DNxHD® Hi 10 bits, DVCPRO
HD 100mbps, XDCAMHD, ProRes 422 SQ, ProRes 422 HQ, ProRes 422 LT, AVC
Intra, H-264, AVC Intra 50, AVC Intra 100.
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3.3.5. Off-line Nearline Files

Introduction
Off-line files are displayed in the Database Explorer when theShow off-line files option
is selected from the View menu available on the toolbar.

Display Off-line Clips or Clip Elements
All off-line clips and clip elements are displayed in italic.

A clip is off-line when all its clip elements are off-line.

For example, a clip which contains an off-line high resolution file and an on-line low
resolution XT clip will be on-line, even for "high resolution only" browsers.

Operations on Off-line Clip or Clip Elements
The following operations are not allowed on off-line clips or clip elements:

• left-click

• right-click

• drag-and-drop

• double-click

• assignmode

• modify assigned keywords

• browsemode

• play mode

3.3.6. Status of Clip / Clip Elements
When a transportable mediamanaged as an IP Drive storage is inserted or removed from
its host, the status of the clip and clip elements is updated automatically:

• the icon in the Clip Element column is updated: / ↔ /

• the text is changed between normal and italic

• operations are allowed or disabled.
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4. Clips View

4.1. Elements Grid for Clips

4.1.1. Clips Display in the Elements Grid
Clicking the Clips branch of the tree displays the list of clips in the Elements grid. Each
clip is displayed on a separate line within the grid but the view can be expanded thanks to
a small arrow at the beginning of each line. The different clip elements, XT (EVS Server)
clips and files, making up the clip are then displayed on separate lines.

The Clips branch also lists the record trains from the servers present on the XNet. They
appear with the same icon as XT (EVS server) high resolution clip.

Sub-branches only display the corresponding clip elements: XT clips for the EVS video
servers sub-branches, files for nearlines.

4.1.2. Clip Columns
The clip data is organized in columns. Some of the details can be edited from here, others
are for viewing only. All the column headers can be used as filters when performing a
search.

See section "Organizing Columns" on page 14 for details on how to hide or show the
columns.

Most of the columns are described in the table below:

Column Name Description

Thumbnail A reference frame from the clip can be shown to identify thematerial
visually.

Key
Thumbnail

A reference frame from the Key clip can be shown relative to the
selected Fill clip.
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Column Name Description

Name A clip can be automatically named:
• using a configuration setting in the EVS video server
• from the EVS video servers keyboard
• from the IPDirector Control Panel when using it to create clips

Clip Element Displays all the icons corresponding to all the elements included in the
clip. See section "Clip Element Types" on page 19.
Record trains are also listed with the icon (green icon).

LSM ID This is the virtual LDM ID as explained in section "Virtual LSM ID /
Real LSM ID" on page 22.

UmID UmID is a fixed length 8-character ID. The EVS video server
automatically assigns a UmID each new clip. It is used for the unique
identification of a clip on an XNet network.
Within a clip, the UmID of the XT high resolution clip and the UmID of
the high resolution file are the same.
The UmID displayed is the UmID of the high resolution clip, if any.
Otherwise, it is the UmID of the high resolution file.

VarID VarID is a 32-character ID with variable length and format. It is
automatically assigned to new clips. It is mainly used to ensure
redundancy on the system. It can be unique for a clip on the EVS video
server level or on the XNet network level, depending on the EVS
server settings.
Within a clip, the VarID of the XT high resolution clip and the VarID of
the high resolution file are the same.
The VarID displayed is the VarID of the high resolution clip, if any.
Otherwise, it is the VarID of the high resolution file.

Status Displays the archive status of a clip. See section "Transfer Status
Icons" on page 124 for a complete list of all the icons which can be
displayed.

Protected Displays the protection status of a clip. No icon is displayed if the clip
is not protected.
In hi-lo mode, two icons are present, one for each XT clip.
Icons available are:

high resolution clip protected by the IPDirector protocol

low resolution clip protected by the IPDirector protocol

high resolution clip protected by another protocol

low resolution clip protected by another protocol
See section "Clip Protection" on page 29.

T/C IN The IN timecode of the clip, without guardbands.

T/C OUT TheOUT timecode of the clip, without guardbands.

Duration The clip duration from T/C IN to T/C OUT.

Limit IN The Protect IN timecode of the clip including guardbands.

Limit OUT The Protect OUT timecode of the clip including guardbands.
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Column Name Description

Keywords A list of the standard keywords that have been associated with the
clip.

Participants A list of the participant keywords that have been associated with the
clip.

Level A rating can be given to a clip, from zero to three stars. This can be
done during clip creation or later on and can provide a useful search
filter for use in the Database Explorer.

None, , ,

Ganged If the clip is linked to other clips, because it has been created on
ganged recorders, the gang icon is displayed

Type If the clip is a Key Clip, a Fill clip or a normal clip.

Creation Date The date when the clip was created.

Source Name The record source name of the channel where the clip was created.
This name is assigned in the EVS video server set upmenus.
The source name is always the one of the high resolution element,
even if the element is off-line. If there is no high resolution element, the
field is empty.

Storage Concatenation of the storage locations of all the clip elements.

Category Category assigned to the clip in the Ingest Scheduler.

Tape ID Tape ID as ingested in the VTR engine or from an AVID system.

SLSM Indicates if a clip is a Super Motion clip or not

Owner Clip owner identification.

Published All the groups the clip has been published to.

In Bins Provides the list of bins in which the clip has been inserted.

Profile Provides the list of profile names associated to the clip.

Created in
IPEdit

Mentions whether the clip has been created in IPEdit (YES) or not
(NO)

VarID in
Playlist

Indicates whether the clip, based on its VarID, is present in a playlist
(YES) or not (NO).
This takes into account offline playlists and online playlists stored on
any server of the network.

4.1.3. Clip Protection
Clips can be protected by Multicam users or other IPDirector users. The clip protection
will not prevent other users from deleting the clips. However, it will warn them that the clip
is protected and should not be deleted.

Within IPDirector, you can protect and unprotect a clip mainly from the contextual menus
of the Database Explorer and the Control Panel or during the creation of a clip.
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NOTE

When you protect a XT hi-res clip, the lo-res version (if present) is
protected automatically and vice versa. Then, two icons will be
displayed, one for each XT clip. The protect feature does not affect hi-
res or lo-res files.

If a clip is protected by the IPDirector protocol, theProtect icon (hi-res) or (lo-res)
appears in theProtect column of the element.

If the clip is protected by another protocol, theProtect icon (hi-res) or (lo-
res)appears in theProtect column.

NOTE

It is possible to protect a clip via IPDirector if it is already protected by
another protocol. This will ensure that the clip remains protected even
if it is unprotected later by the other protocol.
From IPDirector, it is not possible to remove the clip protection defined
by another protocol.

4.1.4. Clip Contextual Menu
The Clip contextual menu is available when right-clicking a clip in the Elements grid. It
gives access to the actions that can be performed on clips.

NOTE

No contextual menu is available from a record train.

The following commands are listed in the Clip contextual menu:

Cut
Cuts the selected clip.
Only available from the Clips tab when a Bins tree branch is selected.

Copy
Copies the selected item. It can then be pasted into the clipboard or in a bin.

Paste
Pastes a shortcut of the copied clip into the selected bin.
This option is available from the Elements grid when an clip has been copied and a bin is
now selected.

Send to
Provides a list of possible destinations to which the selected clip can be sent. Possible
destinations are:
• the user's default bin
• the user's default playlist
• any target destination visible on the GigE network that has been defined in the Remote

Installer (CleanEdit targets, Avid targets, Final Cut Pro targets, File targets, EVS
servers targets).
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• any target that has been defined in the connected Xsquare (CleanEdit targets, Avid
targets, Final Cut Pro targets, Adobe targets, File targets, EVS servers targets).

• the default archive target.
• Avid catalogs (tagets based on Xsquare templates and defined from the Remote

Installer).
See section "TransferringMedia" on page 111.
TheCreate New Target (X²) option gives access to the Xsquare interface to create or
delete an Xsquare target on the fly. It is available provided that the user has rights for
target creation in User Manager and in Xsquare.

Workflow
A sub-menu displays the list of workflow targets the selected item (file, playlist) can be
sent to.
Conditions:
The user may only see the workflow targets
• if they have been published to the groups (s)he belongs to, and
• if a valid PUBLISH AddOn license key for the corresponding social media or generic

CMS exists. See section Licences Codes in the General Functions user manual.
Selecting a workflow target triggers the workflow processing by theWorkflow Engine for
the selected item. This allows, for example, to publish the item (file, playlist) to one or
several social media such as Facebook, Twitter, Youtube, Twitch or to a generic CMS.

Backup to Nearline
Used for the storage or the backup of the selected item to the default nearline or to a
nearline directory.
Provides a list of possible nearline destinations to which the selected item can be sent as
file, that is to say any destination folder visible on the GigE network that has been defined
in the Remote Installer to allow transfer. The file format is defined in the Remote Installer.
Users can access the A/V material of nearline folders in IPDirector, or restore it on an
EVS server.

Restore to XT
This option is available for a file, if the user has theRestore to XT user right set toAll or
to aSelection of servers.
Restores the clip to an EVS video server, from a file stored on a nearline. This can be:
• the default server, if the user has the right to restore to.

The default server is defined in the XNet network page of the Remote Installer.
• the original location where the clip was previously stored, provided that it is still

available, and if the user has the right to restore to.
• one of the EVS video servers for which the user has the right to restore to.

A submenu is available from each EVS video server to select the server page where
you can restore the clip.

The system restores the clip portion between the IN andOUT points.

Copy by GigE
Copies a clip from an EVS video server to another one by the way of the Gigabit network,
as long as the servers have an operational GigE connection. This menu lists all the EVS
video servers that have aGigE address with sub-menus to select server pages.

Archive
Archives the selected file to the HSM system, on the Archive group defined in the Remote
Installer.
See section "ArchivingMedia" on page 115

Restore from Archive
Restore the selected archived file from the HSM system to a nearline.
See section "Restoring an Archived File to a Nearline" on page 119
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Publish
Opens the Publish window to publish the selected clip, or clip element within the clip, to
selected groups of users, or to selected individual users.
See section "PublishingMedia Items" on page 109.

Delete
Allows the deletion of the selected clip, even if present in a playlist or timeline. See
section "Deleting a Clip" on page 34.
When deleting a clip from an XT node, the corresponding file will not be deleted.
This option is not available if the clip is part of a playlist or if it is currently loaded on a
player channel of an EVS video server.

Delete Selected Clip Elements
This option is only visible by high-low browsers. It is only available when right-clicking a
clip line, not a clip element line from theClips expanded view.
The Delete window is then displayed and allows you to select the clip elements to delete.

See section "Deleting a Clip" on page 34 for information on the option "delete clip if
present in a playlist or timeline".

View Key Clip
Displays the Key clip associated with a selected Fill clip. This option is only active for Fill
clips that are included in a Fill and Key association.

Edit
Opens the Edit Clip window, similar to the Save Clip window, from which the user can
modify the clip information. Metadata is common between all clip elements.

Modify T/C IN or Date
Opens theModify T/C In or Date window from which the user canmodify the IN timecode
or the date of the clip.
See section "Modifying the Timecode or the Date of a Clip" on page 39.
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Generate XML Metadata
The XML file is synchronized for the selected clip or clip element, provided that the
IPDirector workstation has been configured as master. With workstations configured as
slave, an error message is displayed when using this option.

Generate thumbnail
This option is only available to users with admin or mediamanager rights.
Creates a thumbnail for the selected clip, with amaximum of 3 attempts.

Open Associated Logsheets
When a clip contains a log timecode, it is associated with the logsheet this log belongs to.
TheOpen Associated Logsheets option opens a Database Explorer window focused on
the logsheet associated with the clip.

If the clip covers several logs belonging to different logsheets, theOpen Associated
Logsheets option first opens a window with the list of associated logsheets:

NOTE
• The first opened Database Explorer window is used to open the associated

logsheet. If no Database Explorer window is open, a warningmessage is
displayed.

• The log with the timecode closest to the clip TC IN is selected.

Protect
Allows you to protect a clip from deletion:
• A Protect icon appears in theProtect column of the Elements grid when the clip is

protected.
• A message will warn the IPDirector users or theMulticam users who would try to

delete the clip.

Unprotect
Allows you to unprotect the selected clip when it has been protected from IPDirector.

Duplicate
Opens the Duplicate Clip window where you can specify the location (LSM ID) on an EVS
video server of the XNet Network where the copy of the clip must be stored.
Files are not duplicated, even if the command is applied at the clip level.
See section "How to Duplicate or Move a Clip to a Specic Location" on page 37.
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Move
Opens theMove Clip window where you can specify the location on an EVS video server
of the XNet Network where the clip must bemoved.
This command is not available for files.
See section "How to Duplicate or Move a Clip to a Specic Location" on page 37.

Link
Allows you to link selected clips manually. It is only possible to link clips that are not
already associated with other clips.

Unlink
Allows you to unlink the clips linked to the selected clips.

Properties
Displays information related to the clip owner, to the groups or individual users the
selected clip has been published to, and to the playlist(s) where the clip is present.

4.2. Deleting a Clip
When selecting theDelete option from the Clip contextual menu, the Delete Clips window
is displayed:

Deleting a Clip even if Present in a Playlist of Timeline
You can choose whether you want to force the deletion of the clip even if it is present in a
playlist or timeline.

• If you do not tick theDelete clip even if present in a playlist of timeline option in
the Delete Clips window, only clips not present in playlist or timeline could be deleted.

• If you tick theDelete clip even if present in a playlist of timeline option, several
cases can occur depending on whether the playlist or timeline is on-line or off-line.

◦ On-line Timeline

If the clip is present in on-line timeline, the clip will be deleted and the timeline
element will be replaced by a black element.
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◦ On-line Playlist

If the clip is present in an on-line playlist, both the clip and the playlist element will
be deleted.

This may be particularly useful when operators want to purge the servers after the
playlists have been played out.

In case a file is present on the nearline, you will be asked whether you want to
keep it or delete it.

◦ Off-line Playlist

In case you want to be able to reuse the playlist but you do not want to keep the
clip, you need to put the playlist off-line and then force the deletion of the clip from
the Database Explorer. The clip will then be replaced by a virtual element.

If a corresponding file is still present on the nearline, it will be used when browsing
the playlist from the Software Player. In addition, the VarID will be used to restore
the XT clip in the playlist when you put the playlist on-line again.

If no corresponding clip element is available after the deletion of the XT clip, this
latter will be replaced by a virtual element in the playlist.

Deleting a Clip Containing a Nearline File
1. Right-click a clip in the Elements grid of the Database Explorer.

2. Select Delete from the contextual menu.

The Delete Clips window opens.

3. Click Yes.

The DeleteMaster Clips window opens. It states that deleting the clip will also delete
the corresponding nearline file.
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4. (optional) Tick theDelete Archive check box if you want to delete the archived file
together with the clip and nearline file. See section "ArchivingMedia" on page 115.

5. Click Yes.

4.3. Copying or Moving a Clip

4.3.1. Ways to Proceed
Different ways exist to move or copy a clip:

• by drag-and-drop operations

• by theDuplicate orMove options from the contextual menu

• by the GigE connection (for copy only)

NOTE 1

During a Duplicate operation, only the XT clip will be copied, not the
file.
During aMove operation, only the XT clip will bemoved and receive a
new LSM ID. The file will keep the original LSM ID. However, the file
will be listed under the XT / page / bank of themoved clip, no longer
under its previous location.
For example, a clip containing an XT clip and a file with "LSM ID =
621A/01" is moved to position "113A/01". The clip is nomore
displayed in page 6 of server 01. It is listed under server 01, page 1,
bank 1 with "LSM ID = 113A" and contains an XT clip with "LSM ID =
113A" and a file with LSM ID = "621A".

NOTE 2

As some copy or move operations may take place between EVS video
servers on the XNet they will take some time to complete.
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4.3.2. Copying or Moving a Clip Using Drag-and-
Drop Operations
A clip can be selected in the right pane of the Database Explorer and dragged to a new
location in the tree structure in the left pane. The target is highlighted in the tree.

Depending on the option selected in Tools > Settings > General, the copy andmove
functions could be performed in different ways: Windows style, Google style or Dialog
Box style. Refer to section "Settings" in part 1 of the user manual for more information on
these options.

The Dialog Box Style is the default value. When dragging a clip, displays a popup window
and asks the operator for the operation to perform.

Using this technique the clip will be copied or moved to the first available location in the
section of the tree it was dropped upon:

• If the clip is dropped on a server level of the tree it will be placed in the first available
space in the XT clip structure.

• If the clip is dropped on a page level of the tree it will be placed in the first available
space in the page structure.

• If the clip is dropped on a bank level of the tree it will be placed in the first available
space in the bank structure.

4.3.3. How to Duplicate or Move a Clip to a Specic
Location
To duplicate or move a clip to a specific location,

1. Select a clip to bemoved or copied. You can select either themain clip line or the XT
clip line in the Database Explorer.

2. Right-click the clip.

3. SelectMove orDuplicate.

TheMove window or Duplicate window is displayed asking for the LSM ID for the new
location.

4. Type the LSM ID in the Target Clip ID field.

USER MANUAL IPDirector 7.90 Database Explorer

4. ClipsView 37



5. Click theMove button in theMove window, or theOK button in the Duplicate window.

The clip will bemoved or duplicated (copied) to the location specified in the Target Clip
ID field.

4.3.4. How to Copy a Clip to an EVS Video Server
through the Gigabit Ethernet
It is possible to copy a clip to an EVS video server belonging to the same or another XNet
network through theGigE network via the Gigabit Ethernet connection. For more
information, refer to the Technical Referencemanual.

To copy a clip to an EVS video server, proceed as follows:

1. Right-click the clip line or XT clip line corresponding to the clip you want to copy to
another server.

The clip contextual menu is displayed.

2. Select Copy by GigE and then the server you want to copy the clip to.

The clip is copied and the icon appears in theStatus column.

NOTE

When copying a clip to another EVS video server from the same
network, this option can be used rather than the Send to > XT option to
avoid the creation of a target.
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4.4. Modifying the Timecode or the Date of
a Clip

Context of Use
The timecode and date corresponding to the IN point of a clip can bemodified from the
contextual menu. This operation is very useful when re-ingesting a feed whichmust then
be associated to a logsheet, or simply because the A/V material ingested corresponds to
A/V material which was originally recorded at a different timecode and date.

Limitation
This operation only works on clips which do not contain file.

How to Modify the Timecode of the IN Point or the Date of a
Clip
Tomodify the timecode of the clip IN point or the date of a clip,

1. Right-click the clip line (or XT clip line) in the Database Explorer grid.

The clip contextual menu is displayed.

2. SelectModify TC IN or Date.

The following window opens:

3. In the Primary TC area, select the timecode type: LTC orUser.

4. Type the new Timecode IN with the format HH:MM:SS:FF in the LTC / IN field or in
theUSER / IN field.

5. Click the button next to the LTC / DATE IN field or theUSER DATE INfield to
display a calendar and select a new date.

6. Click theSave button to save your changes.
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NOTE

This option is available whenmultiple clips are selected. All the
controls have then empty values and a single change can be applied to
the entire selection at once.
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5. Clip Elements View

5.1. Introduction
A clip element is the physical resource inside the clip: XT clip or media file. Every element
in a clip shares the same TC IN and TC OUT. See section "Clip Element Types" on page
19 for the different kinds of clip elements.

When the Clip Elements plugin is enabled and selected in the Tree view, a flat view of the
clip elements list is displayed in the Elements grid. Each element is displayed on a
separate line within the grid.

It also lists the record trains from the servers present on the XNet.

5.2. Limitations
• The Clip Elements branch can be viewed only by administrators/media managers or,

in hi-lo mode, by hi-lo browsers with appropriate user rights. They first need to select
theShow Clip Elements Plug-in option from the View contextual menu.

• It is not possible to define a bin rule from the Clip Element node.
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5.3. Clip Elements Tree Structure

Like the Clips branch, the Clip Elements tree structure of IPDirector, makes the following
sub-branches available:

• Physical hardware present on the XNet, such as:

◦ hi-res EVS video servers: displays XT hi-res-clips saved on the hi-res EVS video
servers.

Light clips are listed here as well even if they are not saved on a server but only
refer to a normal clip itself saved on a server.

42 5. Clip ElementsView

EVSBroadcast Equipment SA Issue 7.90.B - June 2020



◦ lo-res EVS video servers: displays XT lo-res-clips saved on the lo-res EVS video
servers

◦ XF[2] or XStore hosting XFile software: displays clips which have been backed up
to XFile and then published from XFile to the XNet

Eachmachine can be searched by browsing the tree from network number > page >
bank.

• On-line nearline: displays hi-res and lo-res files which have been backed up to
nearline/IP drive and for which the IP drive is still present on the XNet, so they still can
be immediately retrievable.

• Off-line nearline: displays hi-res and lo-res files which have been backed up to
nearline/IP drive and for which the IP drive has been removed. So, IP drive
identification allows files to be retrieved after re-inserting the drive.

5.4. Clip Elements Data Columns
The clip element information is organized in columns. Some of the details can be edited
from here, others are for viewing only. All the headers can be used as filters when
performing a search.

Most of the columns are the same than for Clips. See section "Clip Columns" on page 27.
Differences are listed in the table below.

Column
Name Description

Element Indicates
• File: for hi-res and lo-res files
• EVS Server: for hi-res and lo-res clips
• EVS Server: for XFile backup files which have been published on

the XNet.

LSM ID This is the real LDM ID as explained in section "Virtual LSM ID / Real
LSM ID" on page 22.

Material ID A unique identifier given to an original clip by EVS not generally in use
at an operational level. This ID stays with the clip and will keep track of
copies of a clip related to the original by using this ID as it will not
change on the clip copies.

Hi-Lo Indicates whether the clip element is hi-res or lo-res.
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Column
Name Description

Storage Name of the storage on which the clip element is stored:
• EVS video server for XT clips
• for nearline defined in the configurationmenu: nearline directory for

files
• for detected IP drives: "drive name" on "machine name".
Storage of off-line clip elements are included if Show offline files is
enabled.

Master This information is only for files. The column is empty for clips.
Themaster file is the first file created for a clip element and detected
on the nearline. TheMaster column indicates YES.
When a sub-clip is created from a file, it is flagged as NO in theMaster
column, because it is just a reference to themaster file.

Full Path Only for files.

File Name Only for files.

Cam Pref. Displays a preference value that is generated when clips are created
from an LSM control panel.

Nb Audio
Tracks How many audio tracks the clip has.

Video Format Shows the video format of the clip:
PAL SD 625i, PAL HD 1080i, NTSC HD 1080i, …

Video Codec Shows the video codec of the clip:
DNxHD, MPEG2 i-frame, …

Video Bitrate Shows the video bitrate of the clip: from 20 to 360.

Aspect Ratio 4:3 Letter Box, 4:3 Box, or 16:9.

VBI This has a value when the clip contains information within the picture
such as teletext, VITC or other such data needed by graphics
applications.

Audio Type Mono, Stereo, Dual Stereo, 8 tracks.

HDR Profile High Dynamic Range profile of the clip.

Wide Color
Gamut Wide Color Gamut profile of the clip.

5.5. Clip Element Contextual Menu
The Clip Element contextual menu is displayed when right-clicking a clip element line. It is
the same as the Clip contextual menu obtained from the Clips Elements grid.

See section "Clip Contextual Menu" on page 30 for a detailed description of the different
options available.
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5.6. Deleting Clip Elements
When the user is viewing elements in this view, the only option is to delete directly the
element. There are no options for individual deletion of related elements. See section
"Deleting a Clip" on page 34.

In case of protected clip, the following warning is displayed in theMessage Panel:

If the user is deleting a file, the user must have permissions to delete the file.

If the file is part of a clip, the user will receive a dialog box to delete the file or not.

5.7. How to Manually Associate a Clip
Element to an Existing Clip
Tomanually associate a clip element and an existing clip with matching TC, proceed as
follows:

1. In the Elements grid, select a clip from the Clips view.

2. In the Database Explorer Tools menu, select Clip Element Association.

The Clip Element Association window opens.

3. Drag the clip line on theName field of the Clip Element Association window.

Fields are automatically filled with clip information.

4. In the Elements grid, select a clip element.

5. Drag the clip element line on the right pane of the Clip Element Association window.

The association is created.

NOTE

Both LTC and USER TC must match for the association to be accepted.
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6. Playlists View

6.1. Introduction
A playlist is a group of clips put together to play out in a desired order.

Depending on the required complexity, different video and audio transitions can be defined
between each element of the playlist. Two types of playlist exist: off-line and on-line
playlists. An offline playlist is a playlist that does not yet reside on an EVS video server
but only exists inside the IPDirector database. For more information, refer to the section
on off-line and on-line playlists in the Playlist Panel chapter, in Part 6 of this user manual.

6.2. Playlists Tree Structure
Playlists are stored in bank 0 of each page within an EVS video server. There are 10
spaces per page giving room to 100 playlists per EVS server. The on-line playlists tree
structure of the Database Explorer shows each EVS server and a sub tree for each page.

Right-clicking the playlists tree view gives access to the following contextual menu:

See section "Playlist Contextual Menu" on page 47 for a description of these options.

6.3. Playlists Data Columns
Each playlist record in the list is shownwith variable width columns providing information
about the data stored with the playlist.
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NOTE

See section "Organizing Columns" on page 14 for details on how to
hide or show columns.

Here are some of the columns which can be selected:

Column Name Description

Name A playlist can be named:
• using the EVS video server keyboard
• from the Database Explorer

LSM ID PLNumber and EVS video server number that the playlist is on

Duration Length of the playlist

Nbr of Elements Number of elements in the playlist

AuxClip ID Louth of an auxiliary track associated with a playlist

Owner User who created the playlist

Published Groups to which the playlist is published

Creation Date Date when the playlist has been created

Ganged Displays a ganged group that this PL is linked to

Keywords Displays keywords that are associated to the playlist

Type Displays if this is a normal playlist or defined as Fill or Key

Hi-Lo Displays if this playlist is a hi-res or lo-res PL

6.4. Playlist Contextual Menu
The Playlist contextual menu is available when right-clicking a playlist in the Elements
grid.

For more information, refer to the Playlist Panel user manual.

The commands are described hereafter.

Cut
Cuts the selected playlist.
Only available from the Playlists tab when a Bins tree branch is selected.

Copy
Copies the selected item. It can then be pasted into the clipboard or in a bin.

Paste
Pastes a shortcut of the copied playlist into the selected bin.
This option is available from the Elements grid when an playlist has been copied and a bin
is now selected.

New Playlist
Opens the Create New Playlist window to create a new playlist.
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Copy clips locally
Creates a copy of all distant elements of the selected item onto the local server.
Two options are available:
• Copy short: This copy will only include themedia needed inside the item with minimal

guardbands created during copy.
• Copy long: This copy will include the complete original clips with their guardbands.

Convert to Timeline
Opens theMake a Timeline Online window and allows users to convert the selected
playlist into a timeline which could then bemanaged through IPEdit.

Convert to Edit
Converts the playlist to an edit.

Send to
Provides a list of possible destinations to which the selected playlist can be sent.
Possible destinations are:
• the user's default bin
• any target destination visible on the GigE network that has been defined in the Remote

Installer (CleanEdit targets, Avid targets, Final Cut Pro targets, File targets, EVS
servers targets).

• any target that has been defined in the connected Xsquare.
See section "TransferringMedia" on page 111.
TheCreate New Target (X²) option gives access to the Xsquare interface to create or
delete an Xsquare target. It is available provided that the user has rights for target creation
in User Manager and in Xsquare.

Workflow
A sub-menu displays the list of workflow targets the selected item (file, playlist) can be
sent to.
Conditions:
The user may only see the workflow targets
• if they have been published to the groups (s)he belongs to, and
• if a valid PUBLISH AddOn license key for the corresponding social media or generic

CMS exists. See section Licences Codes in the General Functions user manual.
Selecting a workflow target triggers the workflow processing by theWorkflow Engine for
the selected item. This allows, for example, to publish the item (file, playlist) to one or
several social media such as Facebook, Twitter, Youtube, Twitch or to a generic CMS.

Flatten to XT
This option is available if the user has theRestore to XT user right set toAll or to a
Selection of servers.
Displays a list of high resolution EVS servers and pages available on the XNet network to
which the user can store a consolidated clip out of the selected item.
The flattened clip will have the same VarID as the original item. That is the reason why the
flattened clip cannot be stored on the same EVS server as the original item, otherwise,
this would result in a VarID conflict. This is not relevant for an edit.

Backup to Nearline
Used for the storage or the backup of the selected item to the default nearline or to a
nearline directory.
Provides a list of possible nearline destinations to which the selected item can be sent as
file, that is to say any destination folder visible on the GigE network that has been defined
in the Remote Installer to allow transfer. The file format is defined in the Remote Installer.
Users can access the A/V material of nearline folders in IPDirector, or restore it on an
EVS server.
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Import
Imports the playlist structure and playlist related information from an XML file into
IPDirector.

Export
Exports the loaded playlist structure and playlist related information from IPDirector to an
XML file or CSV file.

Publish
Opens the Publish window in which you can specify the user groups, or the individual
users, the selected item should be published to.
The item will be published to the selected groups, or to the individual users, provided that
they have the adequate rights.

Edit/Rename
Opens the Edit a Playlist window from which the users canmodify the properties of the
selected playlist.

Regenerate TC Output
Generates a continuous timecode to be able to browse a playlist easily.

Delete Playlist
Deletes the selected playlist. The option is only available when the playlist is not loaded
on a player channel.

Delete Playlists and Clips
Deletes the selected playlist and all the clips contained in the playlist, provided that they
are not inserted into another playlist. The option is only available when the playlist is not
loaded on a player channel.
The following window opens and allows you to select the clip element types you want to
delete.

Delete all unused Playlists
Opens the Delete Unused Playlists window from which you can select a reference date
for the deletion of playlists.
All the playlists (on all the EVS servers of the XNet network) not used since the reference
date will be displayed in the window. All the retrieved playlists or a selection of them can
be deleted.

Set as default playlist
Sets the selected playlist as default playlist.
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Create an off-line copy
Creates an off-line copy of the selected playlist.
This new off-line playlist has the same content as the playlist selected. It also has the
same name but it has no LSM ID.

Copy/Move Playlist
Allows the users to:
• create an off-line or on-line copy of the selected playlist
• move the playlist to another EVS server
• make the playlist off-line.

Link
Links the selected playlists together.

Unlink
Unlinks the playlists linked to the selected playlists.

Properties
Displays information related to the owner and the groups the selected item has been
published to.

6.5. Copying or Moving a Playlist
Different ways exist to move or copy a playlist:

• by drag-and-drop operations: this can be done as explained for clips in See section
"Copying or Moving a Clip Using Drag-and-DropOperations" on page 37.

• by theCopy/Move option from the contextual menu: this can be done as explained in
section "Copying andMoving a Playlist".

6.6. How to Delete A Playlist
To delete a playlist, proceed as follows:

1. Right-click the playlist to delete.

The Playlist contextual menu opens.

2. Select Delete Playlist.

3. Confirm the deletion in the Delete Playlist(s) window that appears.

The playlist is deleted from the EVS video server and from the Database.

6.7. Playlist Imports

Import Options
Importing a playlist can be performed from several locations in the Database Explorer.
This option is always available from

• the Playlist contextual menu of the Playlist tree view (Import…)

50 6. PlaylistsView

EVSBroadcast Equipment SA Issue 7.90.B - June 2020



• the Bin contextual menu of the Bin tree view (Import a Playlist…)

• the Playlists list displayed in the Elements grid (Import…)

How to Import a Playlist
To import the playlist definition,

1. Right-click one of the locations listed above.

A contextual menu is displayed.

2. According to themenu, select Import or Import a Playlist from the contextual menu.

The Import Playlists window opens.

3. In this window, select the file that contains the playlist to import.

4. Click Open.

5. TheMake a Playlist On-line window opens:

NOTE

This window is not displayed when the import is done from the Playlist
node or from the Playlist>Off-line node of the tree view.
In these cases, the playlist is made off-line.

6. Select an EVS video server to make the playlist on-line orNone to make it off-line.

7. Select the Import and restore available files box if you want to restore the clips
making the playlist as well.

NOTE

Files must be on the nearline to be available.
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8. Click OK.

The playlist and the clips are imported.
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7. Timelines View

7.1. Introduction
A timeline is a series of clips put together in a given sequence. Audio and video effects
can be added between the clips of a timeline to create transitions, andmany other editing
actions are possible on a timeline. In a timeline, the video and audio tracks of a clip can be
desynchronized from each other, unlike in a playlist.

In this branch of the tree, you can see timelines but not create or edit them. Timelines are
created, managed and edited in the IPEdit Module which is documented separately.

Unlike the playlist branches of the tree, there is no contextual menu for the Timelines
branch in the Database Explorer tree.

7.2. Timelines Data Columns
Each timeline record in the list is shownwith columns providing information about the data
stored with the timeline.

NOTE

See section "Organizing Columns" on page 14 for details on how to
hide or show columns.

Here are some of the columns which can be selected:

Column Name Description

Name Timeline name

Description Free text description entered in the Create a Timeline window.

LSM ID Timeline number and EVS video server number where the timeline
is stored.

Nbr of Tracks Number of timeline tracks (video + audio)

Audio
Configuration

Number of audio tracks and number of audio channels in the
tracks.

Duration Length of the timeline (hh:mm:ss:ff)

Keywords A list of the standard keywords that have been associated with the
timeline.

Participants A list of the participant keywords that have been associated with
the timeline.
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7.3. Timeline Contextual Menu
You canmanage a timeline via the Timeline contextual menu. To access it, right-click a
timeline in the Elements grid.

The available commands are described hereafter.

Cut
Not implemented.

Copy
Not implemented.

Paste
Not implemented.

Copy/move Timeline
Opens the Copy Timeline window that allows you to create a copy of the timeline and all
timeline elements to another server.

Copy clips locally
Creates a copy of all distant elements of the selected item onto the local server.
Two options are available:
• Copy short: This copy will only include themedia needed inside the item with minimal

guardbands created during copy.
• Copy long: This copy will include the complete original clips with their guardbands.

Publish
Opens the Publish window in which you can specify the user groups, or the individual
users, the selected item should be published to.
The item will be published to the selected groups, or to the individual users, provided that
they have the adequate rights.

Edit/Rename
Opens the Edit a Timeline window from which you canmodify the timeline properties as
entered when the timeline was created. The audio configuration can however not be
modified.

Delete Timeline
Deletes the loaded timeline from the IPDirector database and from the server. This does
not delete the related clips.

Delete Timeline and Clips
Deletes the loaded timeline from the IPDirector database and from the server, as well as
the clips created by the timeline engine.

Send to
Provides a list of possible destinations to which the selected timeline can be sent.
Possible destinations are:
• the user's default bin
• any target destination visible on the GigE network that has been defined in the Remote

Installer (CleanEdit targets, Avid targets, Final Cut Pro targets, File targets, EVS
servers targets).

• any target that has been defined in the connected Xsquare.
See section "TransferringMedia" on page 111.
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TheCreate New Target (X²) option gives access to the Xsquare interface to create or
delete an Xsquare target. It is available provided that the user has rights for target creation
in User Manager and in Xsquare.

Flatten to XT
This option is available if the user has theRestore to XT user right set toAll or to a
Selection of servers.
Displays a list of high resolution EVS servers and pages available on the XNet network to
which the user can store a consolidated clip out of the selected item.
The flattened clip will have the same VarID as the original item. That is the reason why the
flattened clip cannot be stored on the same EVS server as the original item, otherwise,
this would result in a VarID conflict. This is not relevant for an edit.

Backup to Nearline
Used for the storage or the backup of the selected item to the default nearline or to a
nearline directory.
Provides a list of possible nearline destinations to which the selected item can be sent as
file, that is to say any destination folder visible on the GigE network that has been defined
in the Remote Installer to allow transfer. The file format is defined in the Remote Installer.
Users can access the A/V material of nearline folders in IPDirector, or restore it on an
EVS server.

Export Timeline
Allows exporting the definition (EDL) of the selected timeline, in other words the timeline
structure and related information, in .xml format. This does not export the timeline
material.

USER MANUAL IPDirector 7.90 Database Explorer

7. TimelinesView 55



8. Edits View

8.1. Introduction
An edit is a container for an EDL, or Edit Decision List. It is represented by its name, its
metadata and its EDL. The EDL is the representation of the edit.

Edits may have been created from the IPD Xedio plugin, the Director's Cut module of
IPDirector or the IPBrowse application. They can also be created from the conversion of a
playlist. Edits can only bemodified from the CleanEdit interface.

They can be organized in bins and sent to targets.

Right-clicking the Edits tree branch or an edit in the Elements grid gives access to a
contextual menu. See section "Edit Contextual Menu" on page 56 for a description of
these options.

8.2. Edit Contextual Menu
You canmanage an edit via the Edit contextual menu. To access it, right-click an edit in
the Elements grid.

The available commands are described hereafter.

Cut
Cuts the selected edit.
Only available from the Edits tab when a Bins tree branch is selected.

Copy
Copies the selected item. It can then be pasted into the clipboard or in a bin.

Paste
Pastes the copied or cut edit.
Only available from the Edits tab when a Bins tree branch is selected.

New Edit
Opens the New Edit window to create a new edit.
See section "Creating an Edit" on page 57 for more information on the fields available in
this window.

Send to
Provides a list of possible destinations to which the selected edit can be sent. Possible
destinations are:
• the user's default bin
• any target destination visible on the GigE network that has been defined in the Remote

Installer (CleanEdit targets, Avid targets, Final Cut Pro targets, File targets, EVS
servers targets).

• any target that has been defined in the connected Xsquare.
See section "TransferringMedia" on page 111.
TheCreate New Target (X²) option gives access to the Xsquare interface to create or
delete an Xsquare target. It is available provided that the user has rights for target creation
in User Manager and in Xsquare.
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Flatten to XT
This option is available if the user has theRestore to XT user right set toAll or to a
Selection of servers.
Displays a list of high resolution EVS servers and pages available on the XNet network to
which the user can store a consolidated clip out of the selected item.
The flattened clip will have the same VarID as the original item. That is the reason why the
flattened clip cannot be stored on the same EVS server as the original item, otherwise,
this would result in a VarID conflict. This is not relevant for an edit.

Backup to Nearline
Used for the storage or the backup of the selected item to the default nearline or to a
nearline directory.
Provides a list of possible nearline destinations to which the selected item can be sent as
file, that is to say any destination folder visible on the GigE network that has been defined
in the Remote Installer to allow transfer. The file format is defined in the Remote Installer.
Users can access the A/V material of nearline folders in IPDirector, or restore it on an
EVS server.

Import...
Allows importing an edit, together with its EDL andmetadata from an XML file into
IPDirector.

Export...
Allows exporting the selected edit. The whole EDL is copied to an XML file.

Publish
Opens the Publish window in which you can specify the user groups, or the individual
users, the selected item should be published to.
The item will be published to the selected groups, or to the individual users, provided that
they have the adequate rights.

Edit/Rename
Opens the Edit Edit window in which you canmodify the edit information andmetadata as
entered when the edit was created.

Delete edit
Deletes the selected edit(s).

Duplicate
Duplicates the edit by creating a new one with the same name, metadata and EDL.

Properties
Displays information related to the owner and the groups the selected item has been
published to.

8.3. Creating an Edit

8.3.1. Possible Ways for Creating an Edit
From the Database Explorer, users can create an edit in one of the following ways:

• Create an empty edit with an EDL containing the edit metadata. This is done by right-
clicking theEdit tree branch or an edit in the Elements grid, selectingNew Edit from
the contextual menu and filling the New Edit window described hereafter.
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• Convert a playlist into an edit, as described in the Playlist Panel user manual. This is
done by right-clicking a playlist in the Elements grid and selectingConvert to Edit.

8.3.2. New Edit Window

Window Overview
The New Edit window makes it possible to enter general and customer-defined data
(called "metadata") for the edit. It is as follows:

The New Edit window is divided into two panes:

• The left pane contains the edit information, i.e. edit general data.

It is always displayed.

• The right pane contains the edit metadata, i.e. edit data based on customer-specific
fields defined in themetadata profile.

It is displayed by clicking the right area in the Pane Display button .

NOTE

When theEdit/Rename option has been selected from the Edit
contextual menu, the Edit window opens. It is similar to the New Edit
window and it shows the data already entered for the edit. Users will
not be able tomodify some of them.

Content of the New Edit Window

Edit Information Pane
The Edit Information pane contains the following user interface elements.

Tape ID
This identifies the tape on which the edit is stored.
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Name
User-defined name for the edit. It can contain up to 64 alphanumeric characters.
It is mandatory.

VarID
VarID is a 32-character ID with variable length and format. It is automatically assigned to
a new edit. It is mainly used to ensure redundancy on the system. It can be unique for a
clip on the EVS server level or on the XNet network level, depending on EVS video server
settings.

TC Track Start
Timecode value of the first field of the edit.
The default value can be set under Tools > Settings > IPEdit > General > Control
Track Initial Timecode, or left empty so the edit timecode will start at 00:00:00:00.

Description
Free text describing the edit.

Keywords
This area allows you to assign up to five keywords to an edit to qualify its content.
See section "Assigning Keywords toMedia" on page 133 for more information on how to
assign keywords tomedia.

Interest Level buttons
The Interest Level buttons allow users to assign an interest rating to an edit. Four interest
levels can be defined, from no star to 3 stars. The background of the button corresponding
to the selected interest level is blue. The default value is the no star level.

Owner
Name of the user who created the edit.

Aspect Ratio
Aspect ratio of the edit. The possible values are [empty], 4:3, 16:9.
The 16:9 value is automatically selected and cannot be changed when an HD video
standard is choosen.
When the Edit Edit window is opened, an aspect ratio value can only be entered if the field
was previously left empty.

Video Standard
Video standard of the edit.
When the Edit Edit window is opened, a video standard value can only be entered if the
field was previously left empty.

Conversion Type
Conversion type for the aspect ratio of the edit.
If the aspect ratio is set to 16:9, the possible values are 4:3 -> 16:9 (PS), 4:3 -> 16:9
(LB).
If the aspect ratio is set to 4:3, the possible values are 16:9 -> 4:3 (PS), 16:9 -> 4:3 (LB)

Edit Metadata Pane
The Edit Metadata pane contains the following fields:

Current Profile
Drop-down list from which the users with appropriate user rights can select themetadata
profile to be associated with the edit.
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For users who do not have the right to choose ametadata profile, the profile set as default
in theMetadata Profile Management window is automatically applied with its fields and
default values.
For users who have the right to choose ametadata profile, the default profile will be
displayed the first time each user create an item. Afterwards, each user who will have
chosen another metadata profile at edit creation will get this new current profile at creation
of the next item.

Metadata Profile fields
Fields belonging to themetadata profile selected in theCurrent Profile field.
The users canmodify the values of theMetadata Profile fields, if they have appropriate
user rights. Themodifications will only apply to the given edit and not impact the default
values of the profile.

60 8. EditsView

EVSBroadcast Equipment SA Issue 7.90.B - June 2020



9. Bins View

9.1. Introduction
All media connected to a particular project or event can be organized into a bin, regardless
of clip numbers or storage locations. This makes it possible to treat the entire XNet
network and nearline storage as one storage location, searchable by a standard database.

The results of searches can be stored to a bin to allow more immediate access tomedia
whichmay be stored on any machine on the XNet network.

Bins can now also include a Post-Process so-as to perform a function to all items arriving
into a bin.

9.2. Bins Tree Structure

9.2.1. Introduction
The Bins tree structure does not use any of the existing clip structure of the EVS video
platform: it is customized by the users depending on how they want to organize their clips,
playlists, timelines or edits. In the bin tree structure, the following rules are applicable:

• A directory can contain other directories or bins.

• A bin cannot contain a directory or another bin.

9.2.2. Tree View Elements
Bins are logical folders in the IPDirector database.

Selecting this branch displays, in the Elements grid, all the clips, playlists, timelines or
edits which are in bins and bin directories.

The Elements grid contains four tabs, Clips, Playlists, Timelines andEdits, to display
respectively the clips, playlists, timelines and edits which have been sent to the selected
bin or bin directory.

Expanding the Bins view shows the bins and bin directories in the Tree view, as detailed in
the table below:

Tree Branch /
Sub-Branch Description / Elements displayed in the Elements grid

Bin Directory: shows all the elements which are in all the bins and
directories under the selected directory.

Bin: shows all the elements which are in the selected bin.

Bin set as default bin.
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Tree Branch /
Sub-Branch Description / Elements displayed in the Elements grid

Users Bin Directory: shows all the elements which are under all
the System [User] bin directories.
This directory is created by the system when an IPBrowse license is
found in the database. It is visible by all the users but no one can
modify, delete or publish it, nor add a bin or bin directory directly
under this directory.
Expanding the Users Bin Directory view displays the System [User]
bin directories for all the users:

System [User] Bin Directory: shows all the elements which are in
the bins and bin directories for the selected user.
Expanding a System [User] Bin Directory view displays all the bins
and bin directories for the selected user (here: pge). Its name
contains the user logging ID.

This directory is created by the system. It is visible by all the users
but only the owner of the directory and an administrator canmodify,
delete or publish it, or add a bin or bin directory directly under this
directory.

System [User] Bin created by the system for the selected user. Its
name contains the user logging ID.
It shows all the elements put in it by the selected user.
It is visible by all the users but only the owner of the bin and an
administrator canmodify, delete or publish it, or move this bin.

[User] Bin: created by the selected user under its System [User] bin
directory.
It shows all the elements put in it by the selected user.

Default [User] Bin: bin created by the selected user under its
System [User] bin directory and set as default bin.
It shows all the elements put in it by the selected user.

[User] Bin Directory: created by the selected user under its
System [User] bin directory.
It shows all the elements put in it by the selected user.
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9.2.3. Bin Contextual Menu
From the Bins node, different contextual menus can be accessed by right-clicking the
Bins tree node, a bin directory or a bin.

The commands are described hereafter.

Open bin
Opens the bin in a separate window.

Send to
Provides a list of possible destination targets to which the selected bin and its content can
be sent.
The available targets are the targets set from the Remote Installer and the Xsquare targets
set from Xsquare.

Backup to nearline
Provides the list of nearline destinations to which the selected bin and its content can be
sent.

Import a playlist
Opens the Import Playlists window where you can select a playlist to import into the bin.

Publish
Opens the Publish window in which you can specify the user groups, or the individual
users, the selected bin or bin directory should be published to.
The bin or bin directory will be published to the selected groups, or to the individual users,
provided that they have the adequate rights.

New bin
Opens the Create a New Bin window where you can specify the name of the new bin.
This is available from a bin directory or from the Bins node of the tree view. Not available
from a bin nor from the Users bin directory.

New directory
Opens the Create a New Directory window where you can specify the name of the new
directory.
This is available from a bin directory or from the Bin node of the tree view. Not available
from a bin nor from the Users bin directory.

Delete selected
Deletes the selected bin or directory.
Click Yes in the confirmation window that appears to delete the bin or bin directory.
This is not available from the Users bin directory, from any System [user] bin directory,
nor from any System [user] bin.

Rename selected
Opens a window where you can change the name and description of the bin or bin
directory.

Set as default bin
Sets the selected bin as default bin, for use in Send to operations.

Go to default bin
Opens the default bin in a new Database Explorer window.
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Bin rules
Opens a sub-menu with Bin rules operations.

Create a new playlist (off-line)
Opens the Enter off-line playlist namewindow from which you can create a new off-line
playlist based on the selected bin.

Properties
Displays information related to the owner and the groups the selected bin or directory has
been published to.

9.3. Elements Grid for Bins

9.3.1. Introduction
In the element view of a bin, you can select which item type you wish to view by clicking
the corresponding button.

9.3.2. Bin Data Columns
Each bin contains a list of clip elements, playlists, timelines or edits with all the data
available for each item and displayed in columns.

9.3.3. Bin Element Contextual menu
The contextual menus available when right-clicking a bin item in the Elements grid are
similar to those in the Elements grids for each type of items.

The commands that differ from the contextual menus in the other Elements grids are
detailed in the table below.

For information on the common commands, refer to the following sections:

• "Clip Contextual Menu" on page 30,

• "Playlist Contextual Menu" on page 47,

• "Timeline Contextual Menu" on page 54

• "Edit Contextual Menu" on page 56 .
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Command Description

Remove from
bin only Removes the selected item from the bin.

CLIPS: Delete Deletes the selected clip from the bin and the actual clip location.
This option is not available if the clip is part of a playlist or loaded
currently on channels of an EVS video server.

PLAYLISTS:
Delete Playlist

Deletes the selected playlist from the bin and the actual playlist
location.

TIMELINES:
Delete

Deletes the selected timeline from the bin and the actual timeline
location.

9.4. Opening a Bin in a Separate Bin
Window
To open a bin window to drag clips into or see clips that are included in it, double-click the
bin name in the Tree view.
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9.5. Bin Rules

9.5.1. Context of Use
A bin rule is a set of criteria that apply to media items, such as clips, playlists, timelines or
edits:

• A filter applied to items in the Elements grid can be used to define the bin rule, so the
items meeting the filter condition are automatically sent into the bin.

• A post process can be defined in the bin rule, so the items placed into the bin are
automatically sent to a target or nearline, are automatically protected (clips), or are
automatically archived (clips).

• A validity period determines the range of time during which the bin rule is applied.

Youmay define different bin rules for the different types of items within a bin, but the same
validity period applies to all the rules set for the bin.

Items are not removed from the bin if they no longer meet the bin rule.

9.5.2. Defining a Bin Rule

Ways to Define a Bin Rule
A bin rule can contain only a post process, which will apply to items manually put in the
bin. See section "Setting the Post Process Options" below.

A bin rule can also include a filter rule in addition to the post process, so items meeting the
filter condition will be automatically dropped into the bin before being processed according
to the post process. See sections "Using a Filter in a Bin Rule" and "Setting the Post
Process Options" below.

Limitation
Up to 20 bin rules can be applied simultaneously. So, you cannot definemore than 20 bin
rules for the same day.
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How to Define a Bin Rule

Using a Filter in a Bin Rule
1. Apply a filter, with one of the Filtering tools, to the Elements grid.

This can be done from the Elements grid for the selected item (Clips,...) or on a bin
content.

See section "Searching for Media" on page 80 for details.

2. Right-click the bin.

3. Select Bin Rules > Set Current Filter as Bin Filter from the contextual menu.

The Bin Rules window opens. See section "Bin Rules Window" on page 70 for a
detailed description of the window.

4. Select the tab for the type of items you want to define a bin rule for (Clips / Playlists /
Timelines / Edits).

The filter applied is written in theCondition Summary field .

5. (optional) Select theApply bin rule filter to existing clips option if you want the
new rule to apply to existingmaterial.

When the bin rule will be created, any existing itemmeeting the Filter criteria in the
database will be sent to the selected bin.

Setting the Post Process Options
When you do not use a filter condition in the bin rule, start to step 1.

If you have set a filter condition in the bin rule, go to step 4.

1. Right-click the bin for which you want to define a bin rule.

2. Select Bin Rules > Create Bin Rules from the contextual menu.

The Bin Rules window opens. See section "Bin Rules Window" on page 70 for a
detailed description of the window.

3. Select the tab for the type of items you want to define a bin rule for (Clips / Playlists /
Timelines / Edits).
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4. Select destinations where you want to automatically send new items.

◦ For timelines and edits, this can only be a destination/target from the Send to list.

◦ For playlists, this can be a destination/target from the Send to list, or aWorkflow
target.

◦ For clips, this can be a destination/target from the Send to list, a nearline from the
Backup to Nearline list, or aWorkflow target:

So, when creating an item sent to the bin for which the post process has been defined,
the item will automatically be sent to the destination selected in the Bin Rules window.

5. (optional) Select theProtect Clip when inserted in bin option if you want to
automatically protect new clips sent to the corresponding bin.

This option is only available for clips.

6. (optional) Select theCreate an Archive Copy option if you want to archive the
nearline file on the tape library managed by a HSM. Actually, this is the file backed up
to a nearline which is archived, not the XT clip.

See section "Bin Rules Window" on page 70 for a description of the different cases
which can occur.

This option is only available for clips.

Youmust have theUser can archive files user right.

Setting the Validity Period for the Bin Rule
1. Select the range of dates between which the bin rule must be applied in theValidity

from andValidity until fields.

2. Click theSave button in the Bin Rules window.

The clips, playlists, timelines or edits that match the filter you have defined, will now be
automatically copied to this bin.

The clips, playlists, timelines or edits that are placed in the bin will be automatically sent
to the selected destinations.
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Bin Rule Icons
As soon as a bin rule is created, icons will be displayed in the tree view, next to the bin.

A color code is based on the validity dates for the bin rule.

When a post-process condition has been set for a bin, one of the following icons is
displayed next to the bin the Bins tree view: , , .

When a filter rule has been used in a bin rule, one of the following icons is displayed next

to the bin the Bins tree view: , , .

Post Process
Icon

Filter Rule
Icon

Bin Rule
Active? Meaning

(blue) (blue)

No TheValidity from [date] is later than
the current day.
The bin rule is not yet active.

(green) (white)

Yes TheValidity from [date] is earlier
than, or equals to, the current day.
TheValidity until [date] is later than
the current day.

(red) (red)

Yes TheValidity until [date] is the current
day.
The bin rule will expire at the end of
the current day.
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9.5.3. Bin Rules Window

Overview
The Bin Rules Window contains different tabs for Clips, Playlists, Timelines and Edits.

Filter Rules Area
Condition Summary
Indicates the search filter applied to the Elements grid, if any, which is used in the bin rule.

Apply bin rule filter to existing clips checkbox
When selected, the filter rule will be applied to all the existing clips present on the network.
All the clips will be referenced in the bin.

Clear this Filter button
Clears the filter for the selected tab only. This allows clearing a clip filter and keeping a
playlist or timeline filter.
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Post Process Area
Send to
Displays the list of the targets where the item can be automatically sent to. The available
targets are the targets set from the Remote Installer and the Xsquare targets set from
Xsquare.
For clips, Avid catalogs (tagets based on Xsquare templates and defined from the Remote
Installer) are also availbale.
To create a new Avid catalog, right-click an Avid catalog from the Send to area

Backup to Nearline
Displays the list of nearline directories where clips can be sent to.
This option is only available for clips.

Workflow
Displays the list of workflow targets where items can be sent to.
This option is only available for clips and playlists.
Selecting a workflow target triggers the workflow processing by theWorkflow Engine for
the selected clip/playlist. This allows, for example, to publish the item to a social media
such as Facebook, Twitter, Youtube, or to a generic CMS.

Protect Clip when inserted in bin checkbox
Automatically protects the clip when it is sent to the bin.
This option is only available for clips.

Create an Archive Copy
Automatically archive the clip sent to the bin to the HSM. Actually, this is the file backed
up to a nearline which is archived.
This option is only available for clips (files).
Several cases can occur:
• no file exists for a clip to archive and no nearline is selected in the bin rule to back the

clip up: the clip will not be archived.
• no file exists for a clip to archive and a nearline is selected in the bin rule to back the

clip up: the clip will be backed up to nearline and then archived.
• no file exists for a clip to archive and several nearlines are selected in the bin rule to

back the clip up: the clip will be backed up to nearline according to the nearline priority
parameter set from the Remote Installer and the file will then be archived.

• a file already exists on a nearline (A) and another nearline (B) is selected in the bin rule
to back the clip up: the clip will be backed up to the selected nearline (B) but the file
already present on a nearline (A) will be archived.

This option is only available for clips.
Youmust have theUser can archive files user right.

Clear Post processes button
Clears the Post Processes defined for the selected tab only. This allows clearing a clip
post process and keeping a playlist or timeline post process.

Validity Area
The validity dates specify from and until when the bin rule will be applied. The clips,
playlists or timelines matching the bin rules will not be copied to the bin the day before the
Validity from [date] field and no longer be copied after the day specified in theValidity
until [date] field.
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The default Validity from [date] is set to the current day and the default validity period is
one day.

9.5.4. Possible Operations on Bin Rules

Applying the Bin Filter Defined in a Bin Rule to the Bin
If the bin contains more items than those corresponding to the filter which has been
defined in the bin rule for that type of items in that bin, you can quickly apply the filter and
restrict the list displayed in the Elements grid.

1. Select the bin in the Tree view.

2. Right-click the bin.

3. Select Bin Rules > Load current bin filter and then the item type (Clips, Playlists,
Timelines, Edits) from the sub-menu.

The filter defined in the bin rule is applied to the bin.

Modifying a Bin Rule
1. Select the bin in the Tree view.

2. Right-click the bin.

3. Select Bin Rules > Modify Bin Rules from the contextual menu.

The Bin Rules window opens.

4. Select the Clip, Playlist, Timeline or Edit tab, for the elements you want to modify the
rules.

5. Edit the bin rule.

6. Click theSave button.

Deleting a Bin Rule
1. Select the bin in the Tree view.

2. Right-click the bin.

3. Select Bin Rule > Delete Bin Rules from the contextual menu.

The Delete Bin Rules window opens:

4. Click Yes.
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10. Logs View

10.1. Introduction
The logs section of the Database Explorer allows you to browse for logs of any event for
which a log has been created. Then you can use the search features to filter the data.

The Elements grid represents the content of the selected logsheet. Logs are displayed
with the highlighted color associated to each of them at creation in .

The log view can be expanded thanks to a small arrow at the beginning of each line in the
grid to display log entries, Protect Media clips and associated clips.

Refer to the chapter on IPLogger in the user manual for more information.

10.2. Logs Tree Structure

10.2.1. Introduction
You can build and customize the Logs tree structure, by adding and organizing directories.

The Logs tree structure displays directories youmay have created as well as the
logsheets which have been created with IPLogger.

You can take advantage of the log directories by searching all logsheets contained inside
the directory. This allows a search across a range of logsheets instead of all sheets in the
system.

NOTE

If you have selected a directory in the logs tree structure, the system
will disable the Automatic Refresh option for the time being. This is to
minimize wasteful database query updates on the browser window.
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10.2.2. Logs Tree View Elements
Selecting this branch displays, in the Elements grid, all the logs present in the IPDirector
database.

Expanding the Logs view shows the logsheets and log directories in the Tree view, as
detailed in the following table.

Tree Branch /
Sub-Branch Description / Elements displayed in the Elements grid

Log Directory: shows all the logs from all the log sheets which are
in the selected directory.

- - - Log Sheet: shows all the logs which are in the selected log sheet.

Log sheet of which all the logs are protected.

Log sheet of which some of the logs are protected.

Log sheet of which none of the logs is protected.

Log sheet which has been de-activated.

10.3. Contextual Menus

10.3.1. Log Branch and Log Directory Contextual
Menu
Contextual menus are available when you right-click the Logs branch or a log directory in
the Tree view.

The commands are described hereafter.

New Directory
Creates a new log directory. You can create sub-directories in the sameway.

Rename Directory
Renames a new log directory.

Delete
Deletes a log directory from the EVS video server and the database.

Publish
Opens the Publish window to publish the log directory to selected group of users, or to
individual users.
If the Publish action is done from a log directory, all logsheets present in this directory and
its sub-directories will be published to the selected user groups, or to the selected
individual users.

Properties
Displays information related to the owner and the groups the selected item has been
published to.
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10.3.2. Logsheet Contextual Menu
A contextual menu is available when you right-click a logsheet in the Tree view.

The available commands are described hereafter.

Export
Opens the Export a Logsheet window from which you can browse for the destination
folder, select the desired file type and enter a file name.
A logsheet can be exported either in XML or in text format (CSV).
• XML files can be re-imported into another IPDirector workstation at a different

location.
• CSV files can be re-imported into software such as Microsoft Excel ® to produce a

printout.
During the export process, the logsheet keywords and the logs keywords appear in the
XML or CSV file in the order they have been entered by the logger.

Export current logging profile
Opens the Export Profiles window from which you can browse for the destination folder,
select the desired file type and enter a file name.
A logging profile used with a logsheet can be exported in XML format.

Deactivate logsheet
Deactivates a logsheet. This can be done when the logsheet is completed to improve the
performance of the system. Once de-activated, a logsheet cannot bemodified and cannot
be associated to clips. This permits to reduce the network load and database activity.
Refer to the IPLogger chapter for more details.

Reactivate logsheet
Re-activates a logsheet which has previously been de-activated.

Delete
Deletes a logsheet from the EVS video server and the database.

Enter TC Offset
Opens the Enter Logsheet Offset window from which you can set a timecode offset when
logs and clips have been created on different machines, with different timecode values.
Refer to the IPLogger chapter for more details.

Publish
Opens the Publish window to publish the logsheet to selected group of users, or to
selected individual users.
The logsheet will be published to the selected groups, or to selected individual users,
provided that they have the adequate rights.

Properties
Displays information related to the owner and the groups the selected item has been
published to.

10.3.3. Log Entry Contextual Menu
The Log Entry contextual menu is available when right-clicking a log entry from the
collapsed view of the grid. It gives access to the actions that can be performed on logs.
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Field Description

Edit Opens the Edit a Log window that allows users tomodify the logmetadata.
Youmay change some data, such as interest level, color,…, for multiple logs at
once: select all the lines to edit and choose the data you want to associate to all
of them in the Edit log window.

View
and
Edit

Opens the Edit a Log window that allows users tomodify the logmetadata and
loads the log at the log timecode position on the player channel associated with
the Database Explorer window.

View Loads the log on the player channel associated with the Database Explorer
window.

Delete Deletes the selected log entry(ies).

NOTE

Right-clicking a protect media clip or an associated clip from the
expanded view of the log entry in the grid will display the Clip
contextual menu.

10.4. Creating Clips Automatically from a
Log Entry

Introduction
A clip can be automatically created around a log timecode when it is sent to a bin in one of
the following ways:

• drag-and-drop of the log into a bin: the clip can be created on the record train selected
as the preview recorder or on all relevant recorders.

• preselection of a bin at logsheet creation: the clip will be automatically created on the
record train selected as the preview recorder as soon as the log is created, and the clip
will be sent the bin. The user does not have to do any additional operation.

Refer to the "Creating a Logsheet" section in the IPLogger user manual.

Prerequisites
• Pre-Mark and Post-Mark durations must have been set via theAutomatic Clip

Creation based on Logs setting in the Tools > Settings > Clips > General
category.

◦ Pre-Mark: duration between the clip IN point and the log timecode.

◦ Post-Mark: duration between the log timecode and the clip OUT point.

• A binmust have been selected in the Logsheet properties if you want the clip to be
created without drag-and-drop operation.
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How to Create Clips Automatically from a Log Entry by
Drag-and-Drop
To automatically create a clip on the record train selected as the preview recorder,

1. Select the log line in the Database Explorer Elements grid.

2. Drag the log entry onto a bin in the Database Explorer tree or onto an open Bin
window.

A clip is automatically created.

To create a clip on all relevant recorders,

• hold theSHIFT key during the drag-and-drop operation.

Tomake the Save Clip window open and be allowed to name the clip and associate
metadata

• hold theCTRL key during the drag-and-drop operation.
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11. Media Files View

11.1. Introduction
Themedia files are the files which have been stored on the nearline. They can be on-line,
when the physical storage (IP drive or XFile drive) is still present. They are called "off-
line", when the physical storage where they have been stored has been removed and is no
more present. However, the IPDirector keeps all the information related to these off-line
files to enable an easy retrieval of the required files.

See section "NearlineManagement" on page 24 for major details about the nearline.

11.2. Media Files Tree Structure

TheMedia Files branch can be viewed only by administrators/media managers or, in hi-lo
mode, by hi-lo browsers with appropriate user rights, provided that they first enable the
Show Media Files Plugin from the List View contextual menu.

The purpose of this branch is to perform file management operations: delete, copy,
move,…

Within theMedia Files tree structure of IPDirector, sub-branches are available for on-line
media files and for off-linemedia files.

Clicking theMedia Files branch of the tree displays on-line hi-res and lo-res media files as
well as off-line hi-res and lo-res media files in the Database Explorer grid.

They are listed with full file name, file extension and full path of their physical storage
location.

Each line can be expanded in the Elements grid by using a small arrow at the beginning of
each line.
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11.3. Media Files Contextual Menu
Different contextual menus are available.

When you right-click a file from the collapsed view of the element list, theMedia Files
contextual menu is displayed. It gives access to the actions that can be performed on files
from the Database Explorer.

TheRe-Scan XML Metadata option is used in case the import of metadata from the XML
file has been unsuccessful and you want to scan the XMLmetadata file again.

When you right-click a line in the expanded view of the element list, the Clip contextual
menu is displayed. It is the samemenu as the one obtained from the Clip branch of the
tree. See section "Clip Contextual Menu" on page 30 for a detailed description of the
different options available.
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12. Searching for Media

12.1. Selecting the Type of Media Items in
the Tree
The Database Explorer is presented in a tree structure, much likeWindows Explorer.

The Tree view allows the users to browse and perform search in the database and the
nearline. By browsing the tree structure, a selection is made and items are displayed in the
Element grid.

When other search tools (Quick TC Search, Quick Text Search, Grid Filters or Saved
Filters) are already applied, these are then limited to the selected branch.

See section "Tree View" on page 9 for a description of the user interface elements of the
Tree view.

12.2. Filtering Tools
When the IPDirector database contains large amounts of data, it may become difficult to
find a specific element. The Database Explorer offers several ways to refine the list of
elements displayed in the Element grid and speed up your search:

• Quick text search - Enter free text in theQuick Text Search field to perform a search
on a specific string. See section "Quick Text Search" on page 82.

• Quick timecode search – Enter a timecode value in theQuick Timecode field to
perform a quick search on a specific timecode. See section "Quick Timecode Search"
on page 81.

• Advanced search filter – Enter specific criteria in the grid filters to perform a search on
specific metadata associated with the elements. See section "Advanced Search" on
page 88.

All these search tools can be combined.
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An applied filter can be saved for later use. Such a saved filter can then be applied in one
click. See section "Using Saved Filters" on page 106.

A search can also be facilitated by ordering the Elements grid. See section "Elements
Grid" on page 14 for more information.

12.3. Quick Timecode Search

12.3.1. Purpose and Context of Use

TheQuick Timecode search allows searching on a timecode value, associated or not with
a date value, to find this value in the elements displayed in the list.

TheQuick timecode searchmay be conducted on clips, clip elements, logs andmedia
files, but not on playlists nor timelines.

Timecode values taken into account for the search are:

Media Item Timecode values

Clips Protect IN ≤ TC < Protect OUT
Also written "Limit IN ≤ TC < Limit OUT"

Clip Elements Protect IN ≤ TC < Protect OUT
Also written "Limit IN ≤ TC < Limit OUT"

Logs TC – range ≤ TC < TC + range

Media Files Protect IN ≤ TC < Protect OUT
Also written "Limit IN ≤ TC < Limit OUT"

The system performs a search for all the elements which contain the specified timecode
value, among the elements displayed in the Database Explorer grid.

12.3.2. Quick Timecode Search Field Display
To display (or hide) theQuick TC Search field, proceed as follows:

1. Click the small arrow next to theSearch button

.

2. Select Display Timecode Search (orHide Timecode Search) from themenu.

TheQuick TC Search field is displayed:
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Information displayed in theQuick TC Search field can be changed as follows:

1. Right-click the Timecode field.

A contextual menu with the following options is displayed:

◦ Timecode

◦ Timecode and Date

2. Select one of the options.

3. When the date is displayed, clicking it in the Timecode field opens a calendar for date
selection.

The search is performed on timecode and date if the field displays the timecode and the
date.

The search is performed only on timecode if the field does not display the date.

12.3.3. How to Perform a Quick Timecode Search
To perform aQuick TC Search, proceed as follows:

1. Select the tree branch you wish to perform a quick search on.

2. Show the columns you wish to perform a quick search on.

3. Click in theQuick TC Search field.

4. Enter a timecode value in theQuick TC Search field.

5. Press ENTER to apply the Quick TC Search on the selected Database Explorer
branch.

TheQuick TC Search is applied and the search result is displayed in the grid.

6. To clear the applied Quick TC Search, click theX button to the right of the search field

or click theClear All button to clear all filters on the Grid Filter bar and/or from
theQuick search options.

A Quick Timecode searchmay be combined with a Quick Text search. In this case, both
conditions must bemet to give a result in the grid.

12.4. Quick Text Search

12.4.1. Purpose and Context of Use
TheQuick Text Search function is used to perform a search based on free text entered in
theQuick Text Search field. This field is available on the top of the Elements grid:

See section "Search and Filter Associated Buttons" on page 12 for the description of the
buttons associated with theQuick Text Search field.
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Users can enter a search string in one of the following ways:

• Enter the search string in full in theQuick Text Search field.

• Click the arrow next to theQuick Text Search field, so the last 10 searches are
displayed, and then select one of them. See section "Quick Text Search Field
Display" on page 84.

• Start to type a search string in theQuick Text Search field, so a list of proposals is
displayed, and one of them can be selected. See section "Performing aQuick Text
Search by Direct Entry" on page 85.

A Quick timecode searchmay be combined with a Quick text search. In this case, both
conditions must bemet to give a result in the grid.

12.4.2. Search on Displayed / All Columns

Search on Displayed Columns
By default, the columns that are taken into consideration for the Quick Text Search are the
ones currently visible in the Elements grid. You can add other columns to the Elements
grid view by right-clicking the grid header and selectingOrganize from the contextual
menu.

Search on All Columns
To activate theSearch on All Columns option, click the small arrow next to theSearch
button and select Search on all columns from the contextual menu:

When this search function is active, theSearch button is highlighted:

or .

Then you can perform the search in theQuick Text Search field as usual.

To deactivate the option, select again theSearch on all columns option.

NOTE

When theSearch on All Columns option is activated, the search
process may be slower.

TIP

If you perform a Search on all columns without having displayed all the
columns, you will not be able to identify in which column the search
string has been found. For the sake of clarity, it is recommended to
display all columns when you perform a Search on all columns.
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12.4.3. Search for Synonyms
Users have the possibility to perform a search for word synonyms, provided that they
have been defined in the database thesaurus file and that the corresponding option has
been set in the IPDirector General setting Freetext searches behavior.

Then, a search performed with a search string will return the predefined synonyms as well.
This function can be used to search for translated words.

12.4.4. Quick Text Search Field Display
The following table shows the various displays for theQuick Text Search field, and what
they mean:

Display Meaning

The field background is gray:
NoQuick Text Search is applied nor entered.

The field background is red:
The user is typing or has typed a search string, but has not applied it yet, or a
search has been applied but the user has typed another search string in the field
and not applied it yet.

The field background is green:
The user has applied the search string, by pressingENTER. The result of the
Quick Text Search is displayed in the grid.

The down arrow next to theQuick Text Search field gives access to the last 10
searched strings.

12.4.5. Quick Text Search Syntax Rules
TheQuick Text Search option obeys specific rules which can be accessed via theHelp

button next to theQuick Text Search field: .
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The string that you enter in theQuick Text Search field is analyzed according to the
following set of rules:

Search String Search Result

Yellow card Searches for the words yellowAND card. A result will be returned
even if present in two different fields (columns), for example
yellow in Name and card in Keywords.

Yellow | card Searches for whole word yellowOR card. A result will be returned
even if yellow or card is found in at least one field (column).

"yellow card" Searches for exact matches of yellow card.  Between quotes,
every character is considered as character and not as operator or
wildcard.

just* Searches for just at the beginning of a word. A result will be
provided if at least one word begins by just in at least one field
(column).

*ber* Searches for all words that includ ber. A result will be provided if a
word includes the text ber (e.g. Timberlake, Berlin). Using such
type of requests will imply much process on the database and will
be slower.

=card Searches for a whole field matching card.
For example, if a field contains yellow card, the =card condition
will not return any result.

12.4.6. Performing a Quick Text Search by Direct
Entry

Introduction
The Autocomplete function is a help service for the capture of the search string.

As soon as the users start typing in theQuick Text Search field, a menu provides a list of
matching words and sentences known by the system and containing a word beginning
with the typed letters.
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WARNING

Make sure the IP API service is started to be able to use the
Autocomplete function.

Result Types in the Autocomplete List
The list displayed below theQuick Text Search field is made up of different types of
results, as described in the following table.

Icon Description:
The line displays the result corresponding to the typed letters and …

…coming from the local search history. Several lines can be displayed, the
most recent are shown on the top of the list.

… coming from the 100 most popular searches asked to the system since its
startup, and launched from the same tree branch. Several lines can be displayed,
themost frequent are shown on the top of the list.

… coming from an index of words entered in text fields, such as item name, item
source name, item VarID, tape ID, itemmetadata text. Keywords are not indexed
in this list. Several lines can be displayed, sorted alphabetically.

… corresponding to a keyword from a keyword list.

… corresponding to a participant from a keyword list.

The proposals made in the Autocomplete list for the local search, popular search and
indexed words depend on the tree branch selected at the time when a word is typed. For
example, if the Logs view is selected in the tree view, only the searches performed on the
Logs view will be proposed, as well as indexed words attached to logs.

Proposed keywords and participants are not linked to the selected tree branch.

How to Perform a Quick Text Search by Direct
Entry

Search on One String of Characters
To perform aQuick Text search,

1. Select the tree branch you wish to perform a quick search on.

2. Display the columns you wish to perform a quick search on.
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3. Type a search string in theQuick Text Search field.

A list of proposals is displayed as soon as you start to type and it is refined as you go
on typing.

4. Select a line by using themouse or the key.

5. Press ENTER to start the search, or press to clear the selection in theQuick
Text Search field and not apply the search.

The search is launched with the selected proposal on the selected Database Explorer
tree branch.

The search results are displayed in the grid.

NOTE

You can press to clear the entry in theQuick Text Search field
and not apply the search.

6. To clear

◦ the applied Quick Text Search: click theClear button to the right of the
Quick Text Search field.
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◦ all the filters applied, from the advanced search filters, from theQuick Timecode

Search and from theQuick Text Search options: click theClear All
button.

Search on Two Strings of Characters
To perform a search based on two words,

1. Follow steps 1 to 4 from the previous procedure.

2. Press Space bar and then start to type a second word.

A new list of proposals is displayed based on the second word.

3. Select a line by using themouse or the key.

4. Press ENTER.

The search is launched with the two selected proposals on the selected Database
Explorer branch.

12.5. Advanced Search

12.5.1. Purpose and Context of Use
The Advanced Search function is available for more detailed search operations. It allows
searches on specific metadata.

Advanced Search fields can be displayed on the top of the Elements grid, within each
column.
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12.5.2. Displaying Advanced Search Fields

How to Display Advanced Search Fields
To display theAdvanced Search fields, click theShow/Hide Grid Filter Bar button

over the grid.

TheGrid Filter bar is displayed with an Advanced Search field above each column in the
Elements grid.

How to Hide Advanced Search Fields
To hide the Advanced Search fields, click theShow/Hide Grid Filter Bar button again.

12.5.3. Advanced Search Fields Types
Different types of advanced search fields exist:

• free text field: alphanumeric characters can be entered directly in these fields.

◦ in most of the cases, no button is available next to the field, e.g. Name field.

◦ Keywords and Participants search fields can be used by entering free-text
(without using the associated "complex filter" button)

• field with an option list: an arrow giving access to a list of options is available on the
right of the field, .

• field with a complex filter button to the right of the field giving access to a Select Filter
Condition window to define specific search values, e.g. Date field, Keywords field,…
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12.5.4. How to Clear an Applied Advanced Search
Filter
To clear a filter applied on an advanced search criterion,

• Click theX button next to the corresponding criterion:

When filters have been applied from several search tools, all the filters can be cleared at
once:

• Click theClear All (Filters)button next to theQuick Text Search field:

12.5.5. Searching in Free Text Fields

Autocomplete Function in Free Text Search Fields
The Autocomplete function is a help service for the capture of the search string. The
Autocomplete function, described in section "Performing aQuick Text Search by Direct
Entry" on page 85 for the Quick Text Search, is also enabled during searches in free text
search fields of the grid filters.

The Autocomplete list, displayed under free text search fields of the grid filters, is limited
compared to the one shown under theQuick Text Search field. No local search or popular
search will be proposed.

• Only indexed words will be listed under free text fields other thanKeywords or
Participants fields.

• Only keywords will be listed under theKeywords field.

• Only participants keywords will be listed under theParticipants field.

Free Text Search Syntax Rules
The string that you enter in the free text search field of a grid filter is analyzed according
to the same set of rules as for the Quick Text Search. The table below is a reminder of
these rules.
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Search String Search Result

Yellow card Searches for the words yellowAND card. A result will be returned
even if present in two different fields (columns), for example
yellow in Name and card in Keywords.

Yellow | card Searches for whole word yellowOR card. A result will be returned
even if yellow or card is found in at least one field (column).

"yellow card" Searches for exact matches of yellow card.  Between quotes,
every character is considered as character and not as operator or
wildcard.

just* Searches for just at the beginning of a word. A result will be
provided if at least one word begins by just in at least one field
(column).

*ber* Searches for all words that includ ber. A result will be provided if a
word includes the text ber (e.g. Timberlake, Berlin). Using such
type of requests will imply much process on the database and will
be slower.

=card Searches for a whole field matching card.
For example, if a field contains yellow card, the =card condition
will not return any result.

Preliminary Steps
1. Select the tree branch in the Tree view.

2. Display the columns you wish to perform a search on.

3. Display the Grid Filter bar by clicking theShow/Hide Grid Filter Bar button over the
grid.

How to Perform a Search on Free Text
To enter search values in a free text field of the grid filters, proceed as follows:

1. Type a search string in the field.

A list of proposals is displayed as soon as you start to type and it is refined as you go
on typing.

2. Select a line by using themouse or by pressing the key.

The search results are displayed in the grid.
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NOTE

Off-line clips or clip elements are displayed in filters results.

12.5.6. Searching in Non-Free Text Fields

Preliminary Steps
Non-free text search fields of the grid filters give access to an option list to select a search
value or to a Select Filter Condition window to define specific search values.

Before starting a search, do the following steps:

1. Select the tree branch in the Tree view.

2. Display the columns you wish to perform a search on.

3. Display the Grid Filter bar by clicking theShow/Hide Grid Filter Bar button over the
grid.

How to Perform a Search based on an Option List
To set a search criterion from an option list,

1. Click the arrow next to a search field to display the option list for the corresponding
criterion.
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◦ If the list contains at least 10 options, a search field is available above the list. Go
to step 2.

◦ If the list contains less than 10 options, no search field is available. Go to step 3.
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2. (optional) Type a search string in the field to restrict the list of options shown andmore
easily find the one you want.

A list of proposals is displayed as soon as you start to type and it is refined as you go
on typing.

3. Select one or more options as follows:

Operation Click... then...

Select all
the options

All All the options from the entire list are selected and highlighted in blue.
The filter will be applied as follows: option 1OR option 2OR....

Select one
option

one option
(e.g. option 3)

The option is selected and highlighted in blue.
The filter will be applied as follows: results with the option (3) are shown.

Select
several
options

several
options (e.g. 1
and 4)

The options are selected and highlighted in blue; then the filter is applied.
Results with one of the options are shown (option 1OR option 4).

Clear the
selection

None All the selections are cleared and nomore option is highlighted in blue or
red; then no filter is nomore appllied.

4. Confirm your selection with the button or cancel and exit by clicking the

button.

NOTE

TheAll button selects all the options at once.
TheNone button clears all the selections at once.
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How to Perform a Search based on a Date
To set a search criterion based on a date or a period of time:

1. Click theComplex Filter button next to aDate field

The following window opens:

2. Enter a date condition in one of the following ways:

◦ Select a specific date from the calendar

Click .

The search condition is displayed in theCondition field.

◦ Select a period of time between two dates:

a. Select From...To... on the right.

b. Select a start date from the calendar.

c. Click

d. Select a end date from the calendar.

e. Click .

The search condition is displayed in theCondition field: From [start date] to
[end date]

◦ Select a period since a date:

a. Select Since / In the last on the right.

b. Select a start date from the calendar, or select the Today option or select the
Yesterday option.
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c. Click .

The search condition is displayed in theCondition field: Since [selected date]

NOTE

TheSince Today optionmeans "from today 00:00 until now".
TheSince Yesterday optionmeans "from yesterday 00:00 until now".

◦ Select a relative time period in the last hours or days:

a. Select Since / In the last on the right.

b. Select the [X hours] option or the [X days ] option.

c. In the field underneath, enter the number of hours or days you want to search
for.

d. Click .

The search condition is displayed in theCondition field: In the last [X] hours or
In the last [X] days.

NOTE

The Last [X] days options includes Today and [X] days.

◦ Select a period older than a date:

a. Select Older than on the right.

b. Select a start date from the calendar, or select the Today option or select the
Yesterday option.

c. Click .

The search condition is displayed in theCondition field: Older Than [selected
date]

◦ Select a relative time period older than a number of hours or days:

a. Select Older than on the right.

b. Select the [X hours] option or the [X days ] option.
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c. In the field underneath, enter the number of hours or days you want to exclude
from your search.

d. Click .

The search condition is displayed in theCondition field: Older than [X] hours or
Older than [X] days

3. Click OK.

The search is launched on the selected tree branch.

The search results are displayed in the grid.

To set a search criterion based on a combination of dates or periods of time:

1. Click theComplex Filter button next to aDate field

The following window opens:

2. Enter one of the date conditions as mentionned in the above procedure.

3. Click .

The search condition is displayed in theCondition field.

4. Enter a second date condition as mentionned in the above procedure.

5. Click .

The search condition is displayed in theCondition field: [First search condition] OR 
[Second search condition], as an example:

6. Click OK.

The search is launched on the selected tree branch, based on the two search criteria.

The search results are displayed in the grid.
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How to Perform a Search based on a Duration
To set a search criterion based on a duration,

1. Click theComplex Filter button next to aDuration field

The following window opens:

2. Enter a duration condition in one of the following ways:

◦ enter a single value in the Timecode field

◦ use the logical operators from the lower pane to construct amore complex search
condition:

3. Click Add.

The search condition is displayed in theCondition field.

4. Click OK.

98 12. Searching for Media

EVSBroadcast Equipment SA Issue 7.90.B - June 2020



How to Perform a Search based on a Timecode
To set a search criterion based on a timecode, proceed as follows:

1. Click theComplex Filter button next to a Timecode field

The following window opens:

2. Enter a timecode condition in one of the following ways:

◦ select a specific date from the calendar

◦ select one of the relative date from the Last xx list

◦ use the logical operators from the right pane to construct amore complex search
condition:

- Select a logical operator

- Enter a timecode value

- Click Add or press ENTER. It appears in theCondition field.

- Enter a second timecode value

- Click Add or press ENTER.

The whole search condition is displayed in theCondition field.

3. Click OK.

The search is launched on the selected tree branch.
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How to Perform a Search based on a Number
To set a search criterion based on a number,

1. Click theComplex Filter button next to aNumber field

The following window opens:

2. Enter a number condition in one of the following ways:

◦ enter a single value in theNumber field

◦ use the logical operators from the right pane to construct amore complex search
condition:

3. Click Add.

The search condition is displayed in theCondition field.

4. Click OK.

NOTE

Operators belonging to different groups may be combined.
• Group 1: AND, OR
• Group 2: NOT
• Group 3: <, >, <=, >=
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How to Perform a Search based on Clip Element
Types
To set a search criterion based on a selection of clip elements, proceed as follows:

1. Click theComplex Filter button next to aClip Elements field

The following window opens:

2. Select the options depending on whether you want to search for clips with or without
the different element types.

3. Click OK.
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How to Perform a Search based on the Transfer
Status
To set a search criterion based on the transfer status, proceed as follows:

1. Click theComplex Filter button next to aStatus field

The following window opens:

2. Select the options based on the transfer status and the destinations themedia has
been sent to.

Targets: lists all the targets defined in the Remote Installer.

◦ the Xsquare targets (SOAP jobs) set from Xsquare and still available

◦ the Xsquare targets (SOAP jobs) set from Xsquare which does not exist anymore

◦ the targets set from the Remote Installer.

Nearline directories: lists all the nearline directories, as defined in the Remote
Installer.

Gigabit copy XTs: lists all the EVS video servers which are part of the workgroup, as
defined in the remote installer.

3. Click OK.

NOTE

Icons for destinations targets may have been customized from the
Remote Installer.
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How to Search for One or Several Keywords
To set a search criterion based on keyword(s), proceed as follows:

1. Click theComplex Filter button next to aKeywords field

The following window opens:

2. Select a Keyword Grid or a Dictionary in the Search For pane, or click in theSearch in
Keyword List field.

The selected Keyword grid or dictionary, or the Keyword list, is displayed in the lower
right area of the window.

3. Select a keyword.

It appears in the Selected Keywords area and in theKeyword Condition or
Participant Condition field.

Keywords which have been selected are shownwith a different color in the Keyword
grid, dictionary or Keyword list.

4. If required, select a logical operator. The NOT operator may be combined with one of
the other operators.

5. Select a second keyword.

The whole condition is shown in theKeyword Condition orParticipant Condition
field.

6. Click OK.

The filter is applied to the Elements grid and the filter condition is displayed in the
Keywords field.

See section "Searching for Child Keyword Based on Parent Keyword" on page 104 for
advanced search based on a parent keyword defined in a dictionary.
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Searching for Child Keyword Based on Parent
Keyword

Context of Use
Child and parent keywords can be defined in a tree structure into the IPDirector Dictionary
tool. See section "Keywords Management" in the IPDirector user manual for more
information.

During an event, the administrator can define all the player names of a football team as
child keywords of the parent keyword "team name" or "country". Users can then assign a
child keyword to logs or clips.

From the Elements grid, it is thereafter possible to retrieve themedia linked to all the child
keywords of the same parent keyword by using the recursive option.

How to Retrieve Child Keywords
To retrieve themedia linked to all the child keywords of the same parent keyword,

1. In the Tree view, select the tree branch you wish to perform a search on.

2. In the grid, show the columns you wish to perform a search on.

3. Display the Grid Filter bar by clicking theShow/Hide Grid Filter Bar button over the

grid .

4. Tick theRecursive checkbox from the Keywords advanced search field to perform a
search on all the child keywords linked to the selected parent keyword

5. Click the Complex Filter button .

The Select Filter Condition (Keywords) window opens.
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6. Select a Keyword Grid or a Dictionary in the Search For pane.

The related keywords are displayed in the list.

7. Select the parent keyword on which you want to perform a search.

It is displayed in theKeywords Condition field.

8. Click theRecursive button if you have not selected theRecursive option from the
Keywords advanced search field).

9. Click OK.

The list of elements containing a child keyword of the selected parent keyword is
displayed in the Elements grid.
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12.6. Using Saved Filters

12.6.1. Introduction
Once you have selected some search filters, you will be able to save this selection of
empty fields as a search template.

Once you have selected some search filters and defined search values for each of them,
you will be able to save the selection as a filter for later use.

You will then be able to apply a template of search filters or a set of applied filters with a
single click.

Saved filters will be common between:

• the Clips tree and the Clip view in bins

• the Playlists tree and the Playlists view in bins

• the Timelines tree and the Timelines view in bins

12.6.2. How to Save Filters
To save filters,

1. Define the filters you wish to save.

2. Do one of the following actions:

◦ Make sure the Saved Filters pane is visible under the tree view by clicking the

button and click theSave Filter button in the
Saved Filters pane.

◦ Click the button above the Elements grid.

The following window is displayed:

3. Enter a name for the applied filters set.

4. Click OK to confirm.

The new filter name is listed in the Saved Filters pane.

106 12. Searching for Media

EVSBroadcast Equipment SA Issue 7.90.B - June 2020



12.6.3. How to Apply a Saved Filter
To apply a saved filter,

1. Make sure the Saved Filters pane is visible under the tree view by clicking the

button.

2. Select the desired filter(s) in the Saved Filters pane.

◦ Click to select a single filter

◦ CTRL + click to select non-contiguous filters

◦ SHIFT + click to select contiguous filters

3. Click theAPPLY button in the Saved Filters pane.

Your filters are shown in the grid filter bar and/or quick search fields and they are
applied in the grid.

12.6.4. How to Update a Saved Filter
To update a saved filter, proceed as follows:

1. Make sure the Saved Filters pane is visible under the tree view by clicking the

button.

2. Select the filter you wish to update in the Saved Filters pane.

3. Click theAPPLY button.

4. Make the desired changes to the filter definition.

5. Right-click the filter name in the Save Filter pane.

A contextual menu is displayed.

6. Select Update from themenu.

7. Click Yes to the confirmationmessage that appears.

The filter is updated.

12.6.5. How to Rename a Saved Filter
To rename a saved filter, proceed as follows:

1. Make sure the Saved Filters pane is visible under the tree view by clicking the

button.

2. Select the filter you wish to rename in the Saved Filters pane.
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3. Right-click the filter and select Rename from the contextual menu.

The Rename Filters window opened.

4. Enter the new name in theName field and click OK to confirm.

The filter name is updated in the Saved Filters pane.

12.6.6. How to Delete a Saved Filter
To delete a saved filter, proceed as follows:

1. Make sure the Saved Filters pane is visible under the tree view.

2. Select the filter you wish to delete in the Saved Filters pane.

3. Right-click the filter

4. Select Delete from the contextual menu.

5. Click Yes in the confirmation window that appears.

The Saved Filter is deleted from the Saved Filters pane.

12.6.7. How to Publish a Saved Filter
To publish a saved filter, proceed as follows:

1. Make sure the Saved Filters pane is visible under the tree view.

2. Select the filter you wish to publish in the Saved Filters pane.

3. Right-click the filter.

4. Select Publish from the contextual menu.

The Publish window opens.

5. Select the group(s) you wish to publish the filter to in the Available groups area on the
left. KeepCTRL pressed to select multiple groups.

6. Click theRight Arrow button tomove the selected user groups from the Available
Groups to the Selected Groups area on the right.

7. Click thePublish button.

NOTE

When a filter has been created with the condition "owner = mine" and
saved as a Saved Filter, you can publish it to selected groups. Then,
when the recipient will apply the filter, the condition "owner = mine" will
be applied to himself/herself.
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13. Publishing Media Items
Context of Use

Clips, Playlists, Timelines, Edits, Logs
Publishing amedia itemmakes it visible to the users or to themembers of the group(s) it is
published to.

The followingmedia items can be published from the Database Explorer by selecting the
relevant items from the respective Elements grid : clips (XT clips, files), playlists,
timelines, edits, logs (actually clips containing logs).

For a clip, depending on the line you right-click, different clip elements from the clip will be
published:

Right-click
on… Result

Clip line All the clip elements are published.
The group name or the user name the clip has been published to
appears in thePublished column, next to the clip and all the clip
elements

XT hi-res clip Only the XT clip is published, not the file.
The group name or the user name appears in thePublished column,
next to the clip and the XT clip element.

File Only the file is published, not the XT clip.
The group name or the user name appears in thePublished column,
next to the file.

Bins and Bin Directories
Publishing the whole content of a bin directory or a bin is possible by selecting the bin
directory or the bin from the Tree view. Then, all the items (clips, playlists, timelines,
edits) present in the bin or the bin directory are published to the selected user groups or to
the selected individual users.

All the items (clips, playlists, timelines, edits) sent to the bin after the publication are
automatically published.

When a bin is un-published, all the items (clips, playlists, timelines, edits) present in the
bin remain published.

Log Directories and Logsheets
Publishing a logsheet is possible by selecting it from the Tree view. This publishes all its
logs.

Publishing the whole content of a log directory is possible by selecting the it from the Tree
view. Then, all logsheets present in this directory and its sub-directories will be published
to the selected user groups or to the selected individual users.
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How to Publish a Media Item
To publish amedia item to groups of users from the Elements grid of the Database
Explorer,

1. Right-click it in the Elements grid.

To publish a bin, bin directory, logsheet or log directory,

1. Right-click it in the Tree view.

Then,

2. Select Publish from the contextual menu.

The Publish window opens.

3. Select the user group(s), or the individual users, to which you want to publish the
media item in the Available Groups area on the left. KeepCTRL pressed to select
multiple groups.

TIP

Use theSearch field to search for a group or to search for a user from the
corresponding lists.

4. Click theRight Arrow button tomove the selected groups / users from the Available
Groups to the Selected Groups area on the right.

5. Click thePublish button.

When a user group has been selected, all users belonging to the selected user group and
having visibility rights on themedia items will be able to view it.

To un-publish amedia item to a group of users, or the individual users, repeat steps above
and perform the opposite operation: select the user group, or user, in the Selected Groups
area and click the Left Arrow button.
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14. Transferring Media

14.1. Sending Media to Locations and
Backing Media up to Nearline

14.1.1. Possible Transfer Destinations

Sending Media to Locations
IPDirector gives full flexibility to directly send A/V files to third party systems (i.e. NLE
systems) and storage paths.

Sendingmedia to predefined targets, such as third party systems or file archive targets,
will be performed with theSend to command.

The possible destinations to transfer clips, edits, timelines, or playlists are listed
hereafter.

• the user's default bin, if any

See section "Bin Contextual Menu" on page 63.

• the default playlist, if any

See section "Playlist Contextual Menu" on page 47.

This is only available for clips.

• XT targets

The EVS servers for which the user has visibility right.

• Third party systems (Xedio/CleanEdit, Avid, FCP, Adobe).

The targets may have been set from the Remote Installer or from Xsquare.

• File targets

The file targets may have been set from the Remote Installer or from Xsquare.

• Avid catalogs

The configuration of targets, based on Xsquare templates, to Avid catalogs must have
been done from the Remote Installer.
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NOTE - VISIBILITY OF XSQUARE TARGETS

Xsquare targets are visible provided that
• the Xsquare has been declared in the Remote Installer and that it

can be reached
• the user logged into IPDirector has an Xsquare account with the

same access codes (login and password) in both applications.
• the user belongs to the same groups in both applications
• in Xsquare, targets have been published to a group the user

belongs to (or target visibility for that user is set toAll).

Backing Media up to Nearline
Sendingmedia to nearline storage will be performed with theBackup to Nearline
command from the file element contextual menu in the Elements grid. This is used to store
or back up A/V material to a nearline folder, visible on the GigE network, that has been
defined in the Remote Installer. Users can access the A/V material of nearline folders in
IPDirector, or restore it on an EVS server.

A file can also be copied from one nearline folder to another one by dragging the file from
the Elements grid to the nearline folder on the Tree view

WARNING

Refer to the IPDirector Remote Installer Technical Referencemanual
for more information on the configuration of targets and nearline folders
and to the Xsquare user manual for the configuration of Xsquare
targets.
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Sending Media to Workflow Targets
AWorkflow Engine is integrated with IPDirector to enablemore complex workflows, such
as the publication of media items (clips, playlists) to one or several social media
(Facebook, Youtube, Twitter, Twitch) or to a generic Content Management System.
The workflow definition is the blueprint of your workflow. It lists and defines the different
tasks within the workflow and specifies how these are linked to each other and in which
order they have to be executed. It also describes the input parameters of the workflow and
the input and output parameters of each task.
The workflow definition files are stored on theWorkflow Engine.
Workflow targets are configured from the Remote Installer and can be used from the
IPDirector interface such as any other target. Selecting a workflow target will trigger the
execution of the workflow. The selectedmedia items will then go through the process
defined in the workflow definition file.
Some of the workflow parameters may have been set as "editable from the IPDirector
user interface" during the workflow configuration. In that case, when a workflow target will
be selected to send themedia to, a window will be displayed and allow you to edit such
parameters. Refer to the PUBLISH Add-On for IPDirector manual for more details on each
parameter.

Sendingmedia to a workflow target is done from theSend to > Workflow option of the
Clip contextual menu or from the Playlist contextual menu. This can also be triggered by a
bin rule.

See sections "Clip Contextual Menu" on page 30 , "Playlist Contextual Menu" on page 47
and "Bin Rules Window" on page 70.

14.1.2. Backing Sub-Clips up

Context of Use
On some occasions, an entire event is recorded but the intent is to only keep a record of
specific actions that will happen during this event.

Users record a long file covering the whole event, e.g. Show in the following example.

Then, they create sub-files (e.g. Artist 1) and sub-sub-files (e.g. Action 1), each one
having boundaries set within those of the file it has been created from.

If the parent file (Show) is backed up to nearline, all the sub-files, sub-sub files, and so on,
included in the parent file are automatically backed up to nearline as well.

Actually, only the parent file is considered as Master, other files are references to the
parent file. So, if theMaster file is deleted, all the files referring to it will be deleted as well.
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How to Keep Backed up Sub-Files and Delete the Master
File
1. Back up to nearline the first child sub-file (Artist 1) you want to keep.

The file created on the nearline will becomeMaster.

The sub-sub-file (Action 1) will automatically be backed up to nearline too. So,
additional files will be displayed in the Database Explorer.

Relations to eachMaster file is shown below:

2. Select the parent file (Show) and press Delete.

A message is displayed, indicating that several clip elements will be deleted.

3. Click Yes.

The parent file and its two sub-files are deleted. The other ones are kept.
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14.2. Archiving and Restoring Media

14.2.1. Archive and Restore Environment
Thanks to Archive services, IPDirector communicates with a third party hierarchical
storagemanagement system (HSM) and LTO tape library for files archiving from a
nearline storage and files restoring to a nearline storage.

The HSM system can beOracle DIVA Archive or SGL flashnet.

Several services are involved in the Archive and Restore to nearline process. They are
started from the Remote Installer.

• AS, managed with the Synchro DB service, receives the requests from IPDirector and
communicates with the ATS service. If it stops working, the job waits for theMaster
failover.

• ATS, individual service, receives the requests from the AS service and communicates
with the HSM. If it stops working, the ATS service from another workstation will take
theMaster role. In such cases when different ATS services have been involved in a
job processing, both workstations will be referenced in the Transfer Monitoring
window.

A database is specifically dedicated to the ATS.

14.2.2. Archiving Media

Context of Use
Files stored on a nearline can be archived by a HSM on a low cost storage system (tape
library). This can be done in different ways.

Archiving can be requested from the Save Clip window when the clip is created. See
sections "How to Create a Clip" in the Control Panel user manual. Actually, this is the file
backed up to a nearline which is archived, not the XT clip stored on a server. So, the
archiving is only possible when a nearline has been selected to back the clip up.

Clip archiving can also be done afterwards, from the Database Explorer, as described
below.

A post process can be defined in a bin rule, so the items placed into the bin are
automatically archived. See section "Bin Rules" on page 66.

Once the file has been archived on the HSM, the icon for the archived file clip element
appears in the Clip Element column of the Elements grid: (high resolution) or (low
resolution). The icon is displayed in the Archive column.
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Prerequisites
• A valid Archive / Restore license is needed to use the archive/restore process. The

fixed licenseArchive/Restore Unlimited (key 171)must be imported to XSecure.

• TheEnable Archive in IPD optionmust have been ticked in the Remote Installer
(Configure > Archive, or ATS DB button).

• The ATS servicemust have been configured from the Remote Installer (Configure >
Archive, orATS DB button).

• The ATS service, the EVS Registry service and the Synchro DB servicemust be
started.

• The user needs theUser can archive files user right.

Principles
• XT clips cannot be archived as such to the HSM. They must first be backed up to a

nearline.

• A file already archived cannot be archived twice.

• When amaster file with sub-files is archived, only themaster file is physically
archived but its sub-files (references to themaster file) are listed as archived in the
Elements grid of the Database Explorer.

• A sub-file, which is a child of an archivedmaster file, cannot be selected for archiving,
as it is actually a reference to themaster file. To be able to archive a sub-file, a new
file, corresponding to the sub-file, must first be backed up to the nearline.

High resolution / low resolution files

• If a clip contains both a high resolution file and a low resolution file, only the high
resolution file will be archived from the Clips view.

• If a clip contains several high resolution files, only the one stored on the nearline with
highest priority in the Remote Installer will be archived from the Clips view.

• If a clip only contains low resolution elements, its files can only be archived from the
Clip Elements view, not from the Clips view.

WARNING

When a clip is being created,
• if two different nearlines are selected from the Save Clip window to

back the clip up, one low resolution nearline and one high
resolution nearline, and,

• if the low resolution nearline has a higher priority than the high
resolution nearline (Remote Installer > Storage Priorities >
Nearline Priority)

then the archiving will be done from the file on the low resolution
nearline.
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How to Archive a File from a Nearline to HSM
To archive a file,

1. Right-click the file in the Elements grid of the Database Explorer.

2. Select Archive from the contextual menu.

The file is archived in the HSM Archive group defined in the Remote Installer.

TheArchived icon appears in the Clip Element column of the Elements grid: (high
resolution file in high-resolution configuration and in high/low configurations) or (low
resolution when only low-resolution file is on the nearline). The icon is displayed in the
Archive column.

Multiple files can be selected and archived at once.

Relevant information can also be retrieved from the Archive Date column and from the
Archive Group column of the Elements grid.

Deleting Nearline Files which have been Archived
The files which have been archived can be deleted from the nearline. At that time, you
may decide whether the IPDirector keeps the archived files or not. So, a restore from
archived file to nearline will be possible later on.

1. Right-click a clip in the Elements grid of the Database Explorer.

2. Select Delete from the contextual menu.

The Delete Clips window opens.
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3. Click Yes.

The DeleteMaster Clips window opens. It states that deleting the clip will also delete
the corresponding nearline file.

4. (optional) Select theDelete Archive option if you want to delete the archived file
together with the clip and nearline file.

5. Click Yes.

◦ If you have chosen to delete the archived file (Delete Archive option selected), all
the elements of the clip are deleted.

◦ If you have chosen not to delete the archived file (Delete Archive option cleared),
the nearline file is deleted and the clip gets the Archidel status (file archived, then
deleted from nearline). So, it is still visible in the Database Explorer, provided that
theShow ArchiDel Elements option has been selected from the View menu.

Users will be able to restore it to a nearline later on.

NOTE

If the nearline is deleted from the Remote Installer, you are allowed to
keep or to delete the reference to the nearline files which have been
archived on the HSM. This allows a future restore on nearline in case
the nearline storage is made available again later on.
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14.2.3. Restoring Media

Restoring an Archived File to a Nearline

Context of Use
A file with an Archidel status, whichmeans that it has been archived by the HSM to a tape
library and then deleted from the nearline, can be restored to a nearline afterwards. This
can be the original nearline, or another one. Clips with Archidel elements appear in the
Elements grid, provided that theShow ArchiDel Elements has been selected from the
View menu of the Database Explorer.

They are listed in italics, with the icon is displayed in the Archive column.

Restoring a file from the tape library is requested from the Database Explorer.

A Restore operation can also be requested from the Save Clip window, when a sub-file is
created from a nearline low-resolution file. Then, only the portion of the Archidel high-
resolution file corresponding to the low-resolution sub-file will be restored.

These situations are explained hereafter.

Prerequisites
• A valid Archive / Restore license is needed to use the archive/restore process. The

fixed licenseArchive/Restore Unlimited (key 171)must be imported to XSecure.

• The user must have theUser can see archidel media and theUser can restore
files user rights.

• The nearlinemust be on-line.

Principles
• An archived file which is also online on a nearline can be restored.

• When amaster file with sub-files has been archived, only themaster file has been
physically archived but its sub-files (references to themaster file) are listed as
archived in the Elements grid of the Database Explorer.

When you restore an Archidel master file, all its sub-files listed as Archidel will appear
as restored in the Elements grid of the Database Explorer.
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• Case of several Archidel files existing for a clip:

When you request the Restore operation for such a clip, a single file will be restored.
Priority is given as follows:

a. high resolution file with the smallest duration (in case of sub-clip)

b. high resolution file with the higher nearline priority.

• When amulti-files media item is restored, all its associated files (metadata file, audio
files) are restored but only the video file item is listed in the Elements grid.

How to Restore a Master Archidel File from the Tape
Library to a Nearline
To restore a Archidel file from the tape library to the nearline,

1. Right-click an Archidel file in the Elements grid of the Database Explorer.

2. Select one of the following options from the contextual menu:

◦ Restore from Archive > Restore to original location ([Nearline Name]) to
restore the archived file to its original nearline.

If the nearline has been deleted but the reference to the archived files has been
kept, the file is displayed in the Elements grid, but the option to restore it to its
original location is not available.

◦ Restore from Archive > [Nearline Name] to restore the archived file to one of
the available nearline.

The file is restored on the selected nearline.

NOTE

If several files have been selected, the optionRestore to original
locationwill be displayed without any indication of nearline name.
This option will restore each Archidel file on its original nearline.

The icons in the Clip Elements column of the Elements grid are:

• (online hi-res file) + (archived hi-res file) or

• (online lo-res file) + (archived lo-res file),

as the archived file is back to an on-line nearline.

Partially Restoring a High Resolution File to a Nearline

Context
A high resolution file is ArchiDel and its corresponding low-resolution file is still present on
the nearline. You do not need to keep the entire file, but only a part of it with specific
actions. You can then create a sub-file of the low-resolution file, and the system can
automatically restore the corresponding part of the archived high-resolution file.
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Limitation
The partial restore is only possible if the codec is supported by the HSM.

How to Partially Restore a High Resolution File to a Nearline
To partially restore a high-resolution file on the nearline,

1. Load the low-resolution file on the Software Player, in a Control Panel.

2. Mark a new IN point and/or a new OUT point thanks to the clip creation buttons or
shortcuts to create a sub-file.

3. Click theNew Clip button.

The Save Clip window will open, provided that theOpen Save Clip Window setting
has been selected.

4. Select a nearline.

5. Select theRestore Archived Hi-Res option.

6. Click Save.

Two new clip elements are displayed in the Elements grid:

• a low-resolution file: it is not aMaster file but a sub-file of theMaster low-resolution file
from the nearline,

• a high-resolution file: it is aMaster file restored on the selected nearline and
corresponding to the trimmed low-resolution file.

Restoring Clips from a Nearline to a Server

Context of Use
A file stored on a nearline can be restored to an EVS server as an XT clip element.

This can be done in different ways. A dedicated command is available from the Clip
contextual menu of the Database Explorer Element grid for clips or clips in bins. A drag-
and-drop operation to a Control Panel allows a quick restore of a XT clip which is then
ready for playout.

Prerequisites
• The user must have theRestore to XT user right set toAll or to aSelection of

servers in the User Manager for IPDirector.

Limitations
• The following files cannot be restored to a server: lo-res file, Archidel file, logo, ...
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How to Restore a Clip from a Nearline to an EVS Server
To restore a clip to a server,

1. Right-click the line of an on-line file in the Elements grid, in the Clips view or the
Bins/Clips view.

2. From the contextual menu, select one of the following options:

◦ Restore to XT > Default XT. The default server for Restore operations is defined
from the Remote Installer.

◦ Restore to XT > Original Location > Original XT to restore the clip to its
original LSM ID position on the original EVS video server where it was before. If
the original LSM ID position is nomore available, a warningmessage is displayed.

◦ Restore to XT > Original Location > [Server Name] to restore the clip to the
same LSM ID position as its original one but on a different EVS video server than
the original one. If the original LSM ID position is nomore available, a warning
message is displayed and the restore operation is not performed.

◦ Restore to XT > [Server Name] > [Page Number]. Themenu displays the EVS
video servers for which the user has the right to restore to.

The clip is restored on the selected EVS video server.

How to Restore an XT Clip by Loading a File on a Player
Channel
An XT clip can be quickly restored from a nearline file to a server and be ready for playout.

1. Make sure that a player channel has been associated with a Control Panel.

2. Select an on-line file, for which you want to restore the corresponding XT clip, in the
Elements grid of the Database Explorer.

3. Drag it to the Control Panel.

A message asks whether you want to restore the XT clip.

4. Click Yes.
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The XT clip is restored on the EVS video server.

The playout can start as soon as its first frame has been restored.

14.3. Monitoring the Transfer Status

14.3.1. Context of Use
Transfers of media items can bemonitored from the Transfer Monitoring area.

This includes the following jobs: Send to targets, backup to nearline, restore to XT, copy
by GigE, archive (clips), restore from archive (files), and Send to workflow targets.

Information on the transfer status is available from different areas:

• The Transfer Monitoring window is accessed by clicking the Transfer Monitoring
option of themain window Tools menu.

• The Transfer Monitoring area can be displayed in the Database Explorer by selecting
the Transfer Monitoring option from the Database Explorer Tools menu.

14.3.2. Overview of the Transfer Monitoring Area

USER MANUAL IPDirector 7.90 Database Explorer

14. TransferringMedia 123



The table below describes the various parts of the Transfer Monitoring area:

Name Description

Transfer Jobs
grid

Transfer jobs are presented in rows and all their associated
parameters andmetadata are in columns.

Current
Transfer Only
button

This button gives access to the list of transfers currently in progress
and scheduled. Its background is colored when it is enabled:

To go back to the list of all the transfers, click theCurrent Transfers
Only button again.

Clear History
button

This button removes all the transfers jobs from the list.

Cancel Job
button

This button cancels the selected transfer job. It is available for
transfers currently in progress.

Refresh button This button allows users tomanually refresh the view at a point in
time. Otherwise, the system automatically refreshes the view.

NOTE

• When an item has been sent to amulti-destination target, nearline or Avid
catalog, as many lines as destinations are displayed in the Transfer
Monitoring window to identify the status of each transfer. The overall status
clearly mentions when all the jobs have not been successful.

• When an item is sent to a workflow target used for publication tomultiple
social media ( multi publishing), several lines are displayed, corresponding
to the publication to each social media, with their respective status allowing
to clearly identify a potential problem. The overall status of themain job
clearly mentions when all the jobs have not been successful.

14.3.3. Transfer Status Icons
TheStatus column of the Elements grid gives information on the transfer status of the
selected clips or edits. The table below gives themeaning for most of the icons which can
appear in this column.
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With theBackup to Nearline option, theCopy by GigE option and theSend to option
(for targets set from the Remote Installer), the icon displayed varies according to the
selected option and its color gives indication on the transfer status. Icons for destinations
targets may have been customized from the Remote Installer.

Icon Description

Send to Targets (XML targets set from Remote Installer)

The item is still in the process of being sent to the file target.

The item is still in the process of being sent to CleanEdit application.

The item is still in the process of being sent to Avid.

The item is still in the process of being sent to FCP.

The item has been successfully sent to the file target.

The item has been successfully sent to CleanEdit application.

The item has been successfully sent to Avid.

The item has been successfully sent to FCP.

Item for which the transfer to target has failed.

Item for which the transfer to CleanEdit application failed.

Item for which the transfer to Avid failed.

Item for which the transfer to FCP failed.

Backup to Nearline

The item is still in the process of being backed up to a nearline.

The item has been successfully backed up to a nearline.

When the operation sends the item to several destinations in one click,
one of the transfers has failed (selection of a Xsquare template configured
with several destinations).

Item for which the backup to a nearline failed.

Copy by GigE

The item is still in the process of being sent to an EVS video server
through theGigE network.

The item has been successfully sent to an EVS video server through the
GigE network.

Item for which the transfer to an EVS video server through theGigE
network failed.

With theSend to option (for targets managed by Xsquare, the icon displayed corresponds
to the icon selected in Xsquare for that target.
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For example: (file target), (PremierePro), (CleanEdit), (Avid)

With theWorkflow option, the icon displayed represents the final target involved in the

selected workflow: (Facebook), (Twitter), (Youtube), (Twitch), (multiple
social media), (CMS).

An additional icon is displayed over the first one and its color gives indication on the
transfer status.

Transfer
Status
Icon

Description

The item is still in the process of being sent to the target.

The item has been successfully sent to the target.

Item for which the transfer to the target has failed.

Examples of the icons displayed in the Status column of the Elements grid:

: item being sent to an Xsquare file target

: item successfully sent to Adobe Premiere Pro

: failed transfer of the item to CleanEdit

: item successfully sent to a Youtube workflow

: failed transfer of the item to a Twitter workflow

With theSend to > Avid catalog targets , the color icon gives indication on the transfer
status.

Transfer
Status
Icon

Description

The item is still in the process of being sent to an Avid catalog.

The item has been successfully sent to an Avid catalog.

When the operation sends the item to several Avid catalog destinations in
one click, one of the transfers has failed (selection of a Xsquare template
configured with several destinations and defined as Continue on Error).

Item for which the transfer to an Avid catalog failed.
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15. Loading and Playing Media

15.1. Introduction
There are various ways to load or to load and play amedia on a player channel from the
Database Explorer.

The Browse and Play modes help to perform those actions from a single-click. They are
available from theBrowse, Play andAuto-Play buttons located on the toolbar:

To be able to use thesemodes and automatically play an element or a list of elements
from the Database Explorer, a player channel must have previously been assigned to the
Database Explorer.

15.2. Assigning a Player

15.2.1. Introduction
There are several ways to assign a player channel or the Software Player to a Database
Explorer window. See section "How to Assign a Player Channel or the Software Player"
on page 127.

If a default player channel has been defined from the Channel Explorer, this channel will
automatically be assigned to the Database Explorer, and the IPDirector main window
when you open the application.

See the Channel Explorer manual for more information on how to set and how to clear a
default player channel.

15.2.2. How to Assign a Player Channel or the
Software Player

From the Channel Explorer
Users can assign a player channel to a Database Explorer window from the Channel
Explorer. This can be done in the following way:

• Drag a player channel from the Channel Explorer window and drop it on the Database
Explorer window.

The name of the selected player is displayed in the Associated Channel zone.
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When a channel is assigned to an application, thePlayer icon in the Channel Explorer
window changes from to .

From the Associated Channel Zone Contextual Menu
Users will be able to select a player from the Associated Channel zone.

This can be:

• a player channel from an EVS video server

• the workstation channel, this means the player channel set as linked from the
IPDirector Configuration window of the Remote Installer

• the Software Player, if the workstation has a valid license for the OCX Software
Player, and if the Software Player is currently associated with a Control panel or a
Playlist panel.

To associate a player channel to the application, proceed as follows:

1. Right-click the Associated Channel zone on the right of the Status bar.

A contextual menu is displayed.

2. Select a player from themenu.

The nme of the selected player is displayed in the Associated Channel zone.

If the selected player channel is connected to an IN port of a video router, itself associated
to OUT ports, the name of the router OUT port(s) is displayed after the player channel
name.
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15.3. Loading Media

15.3.1. On the Player Channel Associated to the
Database Explorer
To loadmedia from the Database Explorer on a channel previously assigned to the
Database Explorer (as explained in section "Assigning a Player" on page 127), proceed in
one of the following ways:

• Click theBrowse button to activate the Browsemode.

The button becomes highlighted .

Double-click an element line in the Database Explorer grid. This works would the Play

mode be active or not.

• Use the Browsemode of the BEPlay Remote device. Refer to section BEPlay
Remote Device in the General Functions user manual for more details.

The element is loaded on its first frame on the associated channel.

The corresponding element line in the Database Explorer grid is highlighted in dark green.

NOTE

Nothing happens when trying to browse an off-line file.

15.3.2. On the Player Channel Associated to the
Control Panel
As explained in the chapter describing the Control Panel module, it is possible to load
media from the Database Explorer to the Control Panel by a drag-and-drop operation. This
does not require the association of a player channel to the Database Explorer. Themedia
is then loaded on the player channel assigned to the Control Panel.

NOTE

At that point, you will have the possibility to play themedia by

• pressing thePlay shortcut key to play the element
OR
• clicking thePlay button on the Control Panel if the channel

assigned to the Database Explorer is also assigned to an opened
control panel.
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15.4. Playing Media

15.4.1. Introduction
There are several ways available to play media on a channel from the Database Explorer:

• Load as explained in "LoadingMedia" on page 1 and play by pressing the shortcut key

or clicking thePlay button on the Control Panel.

• Immediately play on the channel assigned to the Database Explorer.

• Immediately play on the channel assigned to the Control Panel.

NOTE

Nothing happens when trying to play an off-line file.

15.4.2. How to Load and Immediately Play an
Element
To play the element on the channel associated to the Database explorer, proceed as
follows:

1. Assign a channel to the Database Explorer as explained in "Assigning a Player" on
page 127.

2. Click thePlay button to activate the Play mode.

The button becomes highlighted.

3. Click an element line in the Elements grid.

The element immediately played out on the channel associated to the Database
Explorer.

The corresponding element line in the Elements grid is highlighted in dark green.

To play the element on the channel associated to a control panel, proceed as follows:

1. In the Database Explorer, select the line corresponding to the element you want to be
played out.

2. Press CTRL key and, still holding it, drag the element line to the Control Panel.

The element is immediately played out on the channel associated to the Control
Panel.

NOTE

The Play mode is not recommended when selecting elements to play
for live transmission as there will be a delay between the loading of the
element and the playout.
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15.5. Playing a List of Elements

15.5.1. How to Load and Immediately Play a List of
Elements
Before playing elements in Auto-Play mode, you need to ensure that a player channel has
been assigned to the Database Explorer. See section "Assigning a Player" on page 127
for more information on this.

To start playing elements in Auto-Play mode, proceed as follows:

1. In the Database Explorer, open the Clips or Clip Elements branch from where you
want to play elements in Auto-Play mode.

2. Click theAuto-Play button on the toolbar.

Auto-Play mode is activated and the button becomes highlighted.

3. Click the first element from where you want to play in Auto-Play mode.

The element is directly played on the player that is assigned to the Database Explorer.
Then all the subsequent elements in the Database Explorer window are played in the
displayed sequence until the last element of the list is finished.

The element being played out is highlighted in dark green in the Database Explorer grid
and the next element is in light green.

NOTE

If playlists or trains are included in a list of elements on which the
Auto-Play mode is applied, they will be skipped.
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15.5.2. Modifying the Playout Sequence in Auto-
Play Mode
Various transport functions are available in Auto-Play mode, to shift the Auto-Play order to
an element that is not the next one in the sequence.

The following transport functions can be executed:

Preload an element Double-click an element in the Database Explorer to preload
it on the player channel.
Then press thePlay shortcut key (P) to play the element.

Load & play an element
immediately

Select an element to load on the player channel and play
immediately.

Load & play an element
after the current one

Pressing theCTRL key while clicking an element plays the
selected element after the current one is played out.

15.5.3. Using Auto-Play Mode in Several Database
Explorer Windows
You can open several Database Explorer windows and use them in Auto-Play mode with
the same player channel or with different player channels assigned.

If different players are assigned, they will be considered as independent from each other.
Using the Auto-Play mode in one of the windows will not affect the second Database
Explorer window.

If the same player is assigned, the Database Explorer window onwhich the Auto-Play
mode has been used last is considered as themaster window. It has the lead over the
player channel.

Using two Database Explorer windows assigned to the same player channel leads to the
following possible situations:

• When the operator performs a search on themaster Database Explorer window, the
current element is played out and the first element of the search results is
automatically chained.

• When the operator performs a search in the secondary Data Explorer window, this
does not impact the Auto-Play in themaster window. The operator needs to activate
the Auto-Play to take the lead over the player channel and start playing the elements in
Auto-Play mode.
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16. Assigning Keywords to Media

16.1. Introduction
Keywords can be assigned or removed by editing themedia item (clip, ingest, playlist,
timeline, edit, log).

This can be done in various ways.

• You can start typing the keyword directly in theKeyword field of Edit window and
select a keyword proposed in the Autocomplete list.

• You can select keywords in a keyword grid, a dictionary or a cascading grid when the
Edit window is displayed or by using the Assignmode.

• You can type the number associated to a keyword in an open keyword grid or an open
cascading grid when the Edit window is displayed or by using the Assignmode.

When a Keyword tool is used, the Edit modemust be inactive (Edit button of the Keyword
tool not highlighted).

To edit a media item from the Database Explorer, the easier way is to work in Assign
mode with a Keyword tool.You can also right-click the item in the Elements grid and select
Edit orEdit/Rename to access the Edit window and work with the Autocomplete function
or with a Keyword tool.

WARNING

It is highly recommended not to use different Keywords tools to add or
remove keywords to amedia item.

16.2. Conditions for the Use of a Keyword
The assignment of a keyword to amedia item will only be possible if the following
conditions aremet.

• Themaximum number of keywords which can be assigned to the item has not already
been reached.

• The keyword typed in theKeyword field exists in the IPDirector database.

• An additional limitation exists for the use of cascading grids: It is not possible to select
more than one keyword per keywords level/set.
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16.3. Assigning a Keyword by Direct Entry

Autocomplete List
The Autocomplete function is a help service for the capture of a keyword.

This is available from the Keywords area of the Edit window.

As soon as the users start typing in theKeyword field, the Autocomplete function
provides a list of matching keywords, standard and participant, beginning with the typed
letters and existing in the Keyword List of the IPDirector database.

How to Assign a Keyword to Media by Direct Entry
To assign a keyword to amedia item by direct entry in theKeyword field, proceed as
follows.

1. Start typing a keyword in theKeyword field.

A list of proposals is displayed as soon as you start to type and it is refined as you go
on typing.

TIP

TheAdd button next to aKeyword field becomes available when all
the letters of a keyword existing in the Keyword List of the IPDirector
database have been typed in theKeyword field.

2. Select a line by using themouse or the key.
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3. Click Add or press ENTER.

The keyword is displayed in the list of keywords assigned to the item.

To remove a keyword assigned to themedia item:

• click theX button next to the corresponding keyword.

To remove all the keywords assigned to themedia item:

• click theClear All button.

16.4. Assigning a Keyword from a Keyword
Tool

16.4.1. Displaying the Keywords Sources
To display one or several list(s) of keywords, proceed as follows:

1. Select the keyword tool you want to work with from the Keywords menu of themain
Application bar.

2. To open a specific dictionary, keyword grid or cascading grid,

a. select the File > Open option

TheOpen [Dictionary /Keyword Grid / Cascading Grid] from Database window
opened.

b. select the required dictionary, keyword grid or cascading grid from the list.

NOTE

You can open several windows with different dictionaries, keyword
grids or cascading grids, if needed.

3. When several keyword grids or cascading grids have been opened, make one of them
active for keyword selection in one of the following ways:

◦ Simply click the window

◦ Use the keyboard shortcut assigned to the window:

+ for the keyword grid or cascading grid open first

+ for the second one, and so on.
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16.4.2. Assigning Keywords to Media from a
Keyword Grid or Dictionary

Introduction
The Keyword Grid and the Dictionary tools can be accessed from the Keywords menu of
the Application bar. Then, a specific keyword grid or dictionary is opened from the File >
Open option of the tool.

A keyword grid can be used with or without numbers associated with each keyword.

A dictionary can be organized according to a tree structure, with parent and child
keywords.

When amedia item is being edited, its associated keywords are highlighted in the
keyword grid or dictionary, provided that it is open.

Display in the Dictionary
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Display in the Keyword Grid:

See the Keywords Management chapter in the General Functions user manual for a
description of the different tools.

WARNING

It is highly recommended not to use different Keywords tools to add or
remove keywords to amedia item.

How to Assign a Keyword in Assign Mode
To assign keywords to amedia item in Assignmode from the Database Explorer, proceed
as follows:

1. Select an item in the Elements grid.

2. Click theAssign button. It becomes highlighted to indicate that the Assignmode is
active.

3. Open a keyword grid or dictionary.

The keywords already assigned to themedia item, if any, are highlighted as follows in

the keyword grid or in the dictionary .

4. Make sure that theApply button of the Keyword tool is available

5. If you want to work with keyword numbers from the keyword grid, select View >

Keyword Numbers or click to view the numbers associated to each keyword.
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6. Select the keywords you want to assign to themedia in one of the following ways:

◦ click it in the keyword grid or in the dictionary.

◦ if the keyword numbers are displayed in the keyword grid, press the key number

corresponding to the requested keyword on the keypad and then press .

7. Click theApply button.

Keywords are assigned to the item and appear inKeywords columns of the Database
Explorer grid.

How to Remove a Keyword in Assign Mode
To remove a keyword, proceed as follows:

1. Un-select it in one of the following ways:

◦ click it in the keyword grid or in the dictionary.

◦ if the keyword numbers are displayed in the keyword grid, press the key number

corresponding to the requested keyword on the keypad and then press .

2. Click theApply button.

How to Assign a Keyword from the Edit Window
To add a keyword from a keyword grid or a dictionary when amedia item is being edited
from the Edit window, proceed as follows:

1. Open the relevant keyword grid or the relevant dictionary.

The keywords already assigned to themedia item, if any, are highlighted as follows in

the keyword grid or in the dictionary .

2. If you want to work with keyword numbers from the keyword grid, select View >

Keyword Numbers or click to view the numbers associated to each keyword.

3. Select the keywords you want to assign to themedia in one of the following ways:

◦ click it in the keyword grid or in the dictionary.

◦ if the keyword numbers are displayed in the keyword grid, press the key number

corresponding to the requested keyword on the keypad and then press .
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It is added to the Keywords area:

:

It is also highlighted in the keyword grid or dictionary.

How to Remove a Keyword from the Edit Window
To remove a keyword when amedia item is being edited from the Edit window , do one of
the following actions:

• click the keyword in the keyword grid or dictionary

• click theX button next to the corresponding keyword in the Keywords areathe Edit
window.

• if the keyword numbers are displayed in the keyword grid, press the key number

corresponding to the requested keyword on the keypad and then press .

It is removed from the Keywords area and it is nomore highlighted in the Keyword tool.

To remove all the keywords:

• Click theClear All button in the Keywords area.

16.4.3. Assigning Keywords to Media from a
Cascading Grid

Introduction
The Cascading Grid tool can be accessed from the Keywords menu of themain
Application bar. Then, a specific cascading grid is opened from the File > Open option of
the tool.

A cascading grid can be used with or without numbers associated to each keyword.

A cascading grid displays sets of keywords according to a waterfall effect. The sub-sets
of keywords displayed will depend upon the keyword selected from the first set, the
second set, and so on. It is not possible to select more than one keyword per keywords
level/set.

See the Keywords Management chapter in the General Functions user manual for a
description of the tool.

USER MANUAL IPDirector 7.90 Database Explorer

16. Assigning Keywords toMedia 139



How to Assign a Keyword in Assign Mode
This procedure describes the case when no keyword has been assigned to themedia item
yet.

To assign keywords to amedia item in Assignmode from the Database Explorer, proceed
as follows:

1. Select an item in the Elements grid.

2. Click theAssign button. It becomes highlighted to indicate that the Assignmode is
active.

3. Open the relevant cascading grid.

The cascading grid displays the first set of keywords.

4. If you want to work with keyword numbers from the cascading grid, select View >

Keyword Numbers or click to view the numbers associated to each keyword.

5. Select the parent keyword you want to assign to themedia item in one of the following
ways:

◦ click it in the cascading grid.

◦ if the keyword numbers are displayed in the cascading grid, press the key number

corresponding to the requested keyword on the keypad and then press .

The keyword is highlighted in the cascading grid. The child keywords from the second
set, if any, is displayed below the first set.

6. (optional) Select a keyword from the second set (click or keypad number).

It is highlighted in the cascading grid. The child keywords from the third set, if any, is
displayed below the second set.

7. (optional) Select a keyword from the third set (click or keypad number).

It is highlighted in the cascading grid. The set of child keywords from the fourth set, if
any, is displayed below the third set.

8. Click theApply button.

Keywords are assigned to the item and appear inKeywords columns of the Database
Explorer grid.

How to Remove a Keyword in Assign Mode
To remove a keyword, proceed as follows:

1. Select an item in the Elements grid.

2. Click theAssign button. It becomes highlighted to indicate that the Assignmode is
active.
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3. Open the relevant cascading grid.

All of the keywords already assigned to themedia item from the current cascading grid
are highlighted in the cascading grid (light blue).

4. Un-select the keyword in one of the following ways:

◦ click it in the cascading grid.

◦ if the keyword numbers are displayed in the cascading grid, press the key number

corresponding to the requested keyword on the keypad and then press .

This automatically un-selects the keyword and its selected child keyword and
collapses the cascading grid to the level under the remaining selected keyword.

5. Click theApply button.

How to Assign a Keyword from the Edit window
To add a keyword from a cascading grid when amedia item is being edited from the Edit
window and no keyword has been assigned yet, proceed as follows:

1. Open the relevant cascading grid.

The cascading grid displays the first set of keywords.

2. If you want to work with keyword numbers from the cascading grid, select View >

Keyword Numbers or click to view the numbers associated to each keyword.

3. Select the parent keyword you want to assign to themedia item in one of the following
ways:

◦ click it in the cascading grid.

◦ if the keyword numbers are displayed in the cascading grid, press the key number

corresponding to the requested keyword on the keypad and then press .
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The parent keyword is added in the Keywords area and it is highlighted in the
cascading grid.

The child keywords from the second set, if any, is displayed below the first set:

4. Select a keyword from the second set (click or keypad number).

The child keyword is displayed in the Keywords area and it is highlighted in the
cascading grid.

The child keywords from the third set, if any, is displayed below the second set:
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5. Select a keyword from the third set (click or keypad number).

The child keyword is displayed in the Keywords area and it is highlighted in the
cascading grid.

The set of child keywords from the fourth set, if any, is displayed below the third set.

All the selected keywords are highlighted in the cascading grid.

NOTE

It is not possible to select more than one keyword per keywords level/set.

6. To remove a keyword, see the section below and the warningmessage.

7. Click OK from the the Edit window to save the item.

How to Remove Selected Keywordsfrom the Edit window
To remove a keyword and its child keywords, when amedia item is being edited from the
Edit window , do one of the following actions:

• click the keyword in the cascading grid
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• if the keyword numbers are displayed in the cascading grid, press the key number

corresponding to the requested keyword on the keypad and then press .

This automatically un-selects the keyword and its selected child keyword and collapses
the cascading grid to the level under the remaining selected keyword.

The same keywords are removed from the Keywords area of the as well.

Example: ClickingBrazil removes Brazil andDida(1), and displays the sub-set of
keywords related to Teams.

WARNING

Clicking theX button next to a selected keyword in the Keywords area of
themedia item leads to a different result:
• the keyword is removed from the cascading grid, the cascading grid is

collapsed and, therefore, does not display its child keywords anymore.
• the keyword is removed from the Keywords areaBUT its child keyword

is not removed. In the follwing example, clickingBrazil does not
remove its child keywordDida(1) from the keywords area:

To remove all the keywords, do one of the following actions:

• Click theClear All button in the Keywords area.

• Click the highlighted parent keyword in the cascading grid.

Rules for the Display of Keywords in Cascading Grids

WARNING

It is highly recommended not to use different Keywords tools to
add/remove keywords to/from amedia item.
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Display of Keywords in an Cascading Grid
In the case when amedia item has been assigned keywords only from a cascading grid
and, later on, is being edited, its associated keywords are highlighted in the cascading
grid:

Rules for the Display of Keywords of a Media Item
Specific rules exist for the display of keywords in the Cascading Grid tool.

In case amedia item has been assigned several keywords from different keywords
assignment processes (Keywords tools, direct entry), some of them could not be
displayed in a cascading grid when themedia item is selected in the Database Explorer or
when it is being edited.

The order according to which keywords have been assigned is taken into account.

The media item ... ...the keyword(s) highlighted
in the cascading grid...

has several keywords from level 1 is the first one encountered in
the list, and its child keywords
if any

has one keyword from level 1 (KW1) and level 2 (KW2) but the KW2
had been selected before KW1 and appears before KW1 in the
Keywords area

...the keyword from level 1 is
the only one displayed
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Rules for the Display of Keywords when Edited

The media item ...
...the edition
of keywords
consists of...

...the keyword(s)
highlighted in the
cascading grid...

has one keyword from level 1, level 2 and level 3 selecting
another
keyword from
level 2 from the
cascading grid

the new keyword from level 2
is added tomedia and the
previous keywords from levels
2 and 3 are removed.
The keyword from level 1 is
still selected.

has one keyword from level 1 (KW1) and level 2 (KW2)
but the KW2 had been selected before KW1, so KW2
appears before KW1 in the Keywords area and only
KW1 is highlighted in the cascading grid

selecting the
KW2 from the
cascading grid

both KW1 and KW2 are
highlighted in the cascading
grid and KW2 appears after
KW1 in the Keywords area

has one keyword from level 1 (KW1), level 2 (KW2)
and level 3 (KW3.1) but the KW3.1 had been selected
before KW2, so KW3.1 appears before KW2 in the
Keywords area and only KW1 and KW2 are displayed
in the cascading grid

clicking
another
keyword from
level 3 from the
cascading grid
(KW 3.2)

The cascading grid highlights
KW1 and KW2 and the newly
selected KW3.2.
The Keywords area displays
KW1, KW 3.1, KW2 and at the
end of the list KW 3.2.

has several keywords from level 1, so both are
displayed in the Keywords area but only the first one
assigned to themedia item is highlighted in the
cascading grid

clicking the
keyword not
highlighted

the "first assigned" keyword is
removed from the Keywords
area and the cascading grid
and the second one is appears
on both sides.
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17. Database Explorer Shortcuts
Keyboard shortcuts are available to perform some operations.

They are listed in the Define Shortcuts windows which can be accessed by clicking the
Tools > Define Shortcuts option from themenu bar of the IPDirector main window and
then selecting the [Application Name] button on the left.

Some shortcuts can be redefined to suit individual preferences. They are displayed in
regular text. Other ones cannot bemodified. They appear as dimmed text.

See section "Shortcut Definition" in the General Functions user manual for more
information.

Description Current Value (editable)

Hide / display explore
+

Open filter toolbar
+

Close filter toolbar
+

Open or activate Text Search filter
+ +

Open or activate Timecode filter
+ +

View - Simple list
+

View - Thumbnail
+

View - Fill & Key
+

View - Thumbnail only
+

Edit element
+

Activate / deactivate BROWSE mode
+

Activate / deactivate PLAY mode
+

Activate / deactivate AUTO CHAIN mode
+ +

Grab thumbnail
+
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Description Current Value (editable)

Play

Var Play
+

Change the speed of the on-air element

Pause

Fast Forward (FF)

Fast Reverse (FR)

E/E

Return

Sanp to LIVE

TAKE
+

Activate / deactivate 2nd controller

Mark IN

Clear IN
+

Goto IN

Mark OUT

Clear OUT
+

Goto OUT

Turn OSD ON or OFF
+

Lock / unlock channel
+

Change LOOP mode

Send clip to default bin
+

148 17. Database Explorer Shortcuts

EVSBroadcast Equipment SA Issue 7.90.B - June 2020



Description Current Value (editable)

Append clip to default playlist
+

Send to archive (default XFile)
+

Save clip

Play backward
+

Play forward
+
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